SAM Office Project Differences for MacOS

Contents

Contents 1

Introduction 2

New Perspectives Excel 2016 3
  New Perspectives Excel 2016 Module 5: SAM Project 1a 3
  New Perspectives Excel 2016 Module 5: SAM Project 1b 3
  New Perspectives Excel 2016 Module 4: SAM Project 1a 4
  New Perspectives Excel 2016 Module 4: SAM Project 1b 5
  New Perspectives Excel 2016 Module 11: SAM Project 1a 5
  New Perspectives Excel 2016 Module 11: SAM Project 1b 8
  New Perspectives Excel 2016 Module 12: SAM Project 1a 12
  New Perspectives Excel 2016 Module 12: SAM Project 1b 12
  New Perspectives Excel 2016 Modules 9-11: SAM Capstone Project 1a 13

New Perspectives PowerPoint 2016 16
  New Perspectives PowerPoint 2016 Module 4: SAM Project 1a 16
  New Perspectives PowerPoint 2016 Module 4: SAM Project 1b 17
  New Perspectives PowerPoint 2016 Module 6: SAM Project 1a 18
  New Perspectives PowerPoint 2016 Module 6: SAM Project 1b 20
  New Perspectives PowerPoint 2016 Modules 3-4: SAM Capstone Project 1a 21
  New Perspectives PowerPoint 2016 Modules 5-6: SAM Capstone Project 1a 22

New Perspectives Word 2016 23
  New Perspectives Word 2016 Module 2: SAM Project 1a 23
  New Perspectives Word 2016 Module 2: SAM Project 1b 24
  New Perspectives Word 2016 Module 4: SAM Project 1a 25
  New Perspectives Word 2016 Module 4: SAM Project 1b 26
  New Perspectives Word 2016 Module 6: SAM Project 1a 27
  New Perspectives Word 2016 Module 6: SAM Project 1b 29
  New Perspectives Word 2016 Module 8: SAM Project 1a 30
  New Perspectives Word 2016 Module 8: SAM Project 1b 31
  New Perspectives Word 2016 Module 9: SAM Project 1a 32
  New Perspectives Word 2016 Module 9: SAM Project 1b 34
  New Perspectives Word 2016 Modules 5-7: SAM Capstone Project 1a 36
  New Perspectives Word 2016 Modules 8-10: SAM Capstone Project 1a 37

Shelley Cashman Excel 2016 39

© 2018 Cengage Learning / Revised January 2018
Introduction

Although most students complete SAM Office projects using Office for Windows, the projects also support students using Office for MacOS. Because of differences between Office products on Windows and MacOS, some project steps are removed or changed for MacOS.
New Perspectives Excel 2016 Module 5: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>7b</td>
<td></td>
<td>Same as Windows, with this addition: (Hint: If an alert message appears reading “Do you want to convert the table to a normal range?”, click Yes.)</td>
<td></td>
</tr>
</tbody>
</table>

16 Maureen also wants to summarize sales data for all products using a PivotChart to help determine what product lines should be expanded. Switch to the Product Material PivotTable worksheet. Insert a PivotChart using the Clustered Column chart type. Format the PivotChart as described below:

   a. Resize and reposition the PivotChart so that the upper-left corner is located within cell F3 and the lower-right corner is located within cell O19.
   b. Add the chart title Sales by Material to the PivotChart using the Above Chart option.
   c. Use the Type axis field button in the PivotChart to filter it so that only the sales data for bracelets and earrings of each type of material appears in the chart.

New Perspectives Excel 2016 Module 5: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>7b</td>
<td></td>
<td>Same as Windows, with this addition: (Hint: If an alert message appears reading “Do you want to convert the table to a normal range?”, click Yes.)</td>
<td></td>
</tr>
</tbody>
</table>

16 Colin also wants to summarize sales data for all products using a PivotChart to help

Removed. PivotChart is not a Mac option.
determine what product lines should be expanded.  
Switch to the Product Material PT worksheet. Insert a PivotChart using the Clustered Column chart type. Format the PivotChart as described below:
   a. Resize and reposition the PivotChart so that the upper-left corner is located within cell F3 and the lower-right corner is located within cell O19.
   b. Add the chart title Sales by Frames to the PivotChart using the Above Chart option.
   Use the Type axis field button to filter the PivotChart so that only the sales data for Prescription and Reading glasses of each type of material appears in the chart.

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 1    | Casey wants a chart representing the distribution of average hours per week that members utilized Inception Workspace in 2024. Switch to the Average Usage 2024 worksheet. Select the range A4:B243 and create a Histogram chart. (Hint: Use the Name box to select the range.) Modify the chart as described below:  
   a. Resize and reposition the chart so that the upper-left corner is located within cell D4 and the lower-right corner is located within cell K18.  
   b. Enter Average Weekly Usage (in Hours) in 2024 as the title of the chart. | Casey wants a chart representing the distribution of average hours per week that members utilized Inception Workspace in 2024. Switch to the Average Usage 2024 worksheet. Select the range D6:E11 and insert a Clustered Column chart. Modify the chart as described below:  
   a. Resize and reposition the chart so that the upper-left corner is located within cell D13 and the lower-right corner is located within cell J28.  
   b. Enter Average Weekly Usage (in Hours) in 2024 as the chart title.  
   c. Format the series by changing the Series Overlap to 0% and the Gap Width to 10%.  
   d. Change the bin width used in the chart by setting cell E4 to 10.  
   e. Change the lower bounds of the chart by setting cell F6 to 15. |                                 |
| 13   | For his loan application, Casey needs to create a chart that displays both the annual income generated by each membership package and Inception Workspace's total annual income. Because of the large difference between the package income and total income values, Casey determines that a combo chart is most appropriate option.  
Select the range A4:G10 and create a Custom Combination Combo chart as described below: | For his loan application, Casey needs to create a chart that displays the annual income generated by each membership.  
   a. Select the range A4:G9 and create a Clustered Column chart.  
   b. Move the chart to the Income Overview worksheet, and then resize and reposition the chart so that the upper-left corner is located within cell A4 and the lower-right corner is located within cell K23.  
   c. Enter Package Annual Income as the chart title. | Combo chart changed to clustered column chart No combo charts on Mac |

New Perspectives Excel 2016 Module 4: SAM Project 1a

© 2018 Cengage Learning / Revised January 2018
### New Perspectives Excel 2016 Module 4: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 1    | Rosella wants a chart representing the distribution of average number of monthly meal orders made by customers in 2024, so she can better understand her customers. Switch to the 2024 Average Monthly Order worksheet. Select the range A4:B230 and create a Histogram chart. (Hint: Use the Name box to select the range.) Modify the chart as described below:  
  a. Resize and reposition the chart so that the upper-left corner is located within cell D2 and the lower-right corner is located within cell L21.  
  b. Enter Average Monthly Orders in 2024 as the title of the chart. | Rosella wants a chart representing the distribution of average number of monthly meal orders made by customers in 2024, so she can better understand her customers. Switch to the 2024 Average Monthly Order worksheet. Select the range D6:E11 and insert a Clustered Column chart. Modify the chart as described below:  
  a. Resize and reposition the chart so that the upper-left corner is located within cell D13 and the lower-right corner is located within cell K28.  
  b. Enter Average Monthly Orders in 2024 as the title of the chart. | Histogram chart changed to clustered column chart  
  No histogram charts on Mac |
| 13   | Rosella wants to create a chart that displays both the annual income generated by each meal plan and Calorie Courier's total annual income. Because of the large difference between the meal plan income and total income values, Rosella decides that a combo chart is the most appropriate option. Select the range A3:G9 and create a Custom Combination Combo chart as described below:  
  a. Represent the following data series as a Clustered Column chart: Two Day, Three Day, Five Day, Seven Day, and On Demand.  
  b. Represent the Total data series as a Line chart using the Secondary Axis, as shown in Figure 1 below. | Rosella wants to create a chart that displays the annual income generated by each meal plan.  
  a. Select the range A3:G8 and create a Clustered Column chart.  
  b. Move the chart to the Income Overview worksheet, and then resize and reposition the chart so that the upper-left corner is located within cell A3 and the lower-right corner is located within cell K24.  
  c. Enter Meal Plan Annual Income as the chart title.  
  d. Add a vertical axis title to the chart, and then enter Meal Plan Income as the vertical axis title. | Combo chart changed to clustered column chart  
  No combo charts on Mac |

### New Perspectives Excel 2016 Module 11: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
|      | © 2018 Cengage Learning / Revised January 2018  
  5 |
<table>
<thead>
<tr>
<th></th>
<th>Switch to the Sales History worksheet. Use Power Query to create a query and load data from a CSV file into a new table as follows:</th>
<th>Switch to the Sales History worksheet. Import the data from a CSV file into a new table as follows:</th>
<th>Imported data from text instead of using Power Query Power BI not on Mac</th>
</tr>
</thead>
</table>
| 1 | a. Create a new query that imports data from the Support_NP_EX16_11a_History.csv file, available for download from the SAM website.  
  b. Edit the query to remove the Units Sold and Notes columns, then close and load the query data to a table in cell A3 of the existing worksheet. (Hint: Use the Close & Load to... button.) | a. Import data from text using the Support_NP_EX16_Mac_11a_History.csv file.  
  b. Start loading the data at row 1, mark the file as having headers, and separate the columns using comma delimiters.  
  c. Edit the data to remove the Units Sold and Notes columns, and load the data into cell A3 of the existing worksheet.  
  d. Format the imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.)  
  e. Use AutoFit to change the width of columns B and C. | Switch to the Current Sales worksheet. Use Power Query as follows to create a query that loads daily sales data from a CSV file and transforms the data to display only monthly totals:  
  b. Remove all columns except the OrderDate and Sales columns.  
  c. Based on the OrderDate column, add a new Date column to the query using the End of Month option. (Hint: Select the OrderDate column before selecting options on the Add Column tab.)  
  d. Use Month as the name of the new column.  
  To display the total sales for each month, group the dates in the Month column and create a new column displaying the sum of the Sales values as follows:  
  e. Transform the data in the Month column by grouping the data by month.  
  f. Use Monthly Sales as the name of the new column.  
  g. Use Sum as the operation.  
  h. Use Sales as the column to sum within the Month group.  
  i. Load the query data to a table in the existing worksheet beginning in cell A3.  
  j. Format the data in the range B4:B27 using the Currency number format with 2 decimal places and the $ symbol. | Switch to the Current Sales worksheet. Load the monthly sales data from a CSV file as follows:  
  b. Start loading the data at row 1, mark the file as having headers, and separate the columns using comma delimiters.  
  c. Edit the data to remove all columns except the Month and Monthly Sales columns, and load the data into cell A3 of the existing worksheet.  
  d. Format the imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.)  
  e. Format the data in the range B4:B27 using the Currency number format with 2 decimal places and the $ symbol.  
  f. Use AutoFit to change the width of column B. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
<th>Instruction</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Create a forecast sheet to track the changes in monthly sales and project next year’s monthly sales as follows:</td>
<td>a. Based on the data in the range A3:B27, create a forecast sheet.</td>
<td>a. Rename the Sheet4 worksheet using Monthly Sales Forecasts as the new name of the sheet.</td>
</tr>
<tr>
<td></td>
<td>b. Using the Options menu in the Create Forecast Worksheet dialog box, manually set the seasonality to 12.</td>
<td>b. Fill the range A26:A37 with the last day of each month in 2020.</td>
<td>b. Fill the range A26:A37 with the last day of each month in 2020.</td>
</tr>
<tr>
<td></td>
<td>c. Use 12/31/2020 as the Forecast End date.</td>
<td>c. Copy the formula from the range C26:E26 to the range C27:E37.</td>
<td>c. Copy the formula from the range C26:E26 to the range C27:E37.</td>
</tr>
<tr>
<td></td>
<td>d. Use Monthly Sales Forecasts as the name of the new sheet.</td>
<td>d. Based on the data in the range A1:E37, create a Line chart.</td>
<td>d. Based on the data in the range A1:E37, create a Line chart.</td>
</tr>
<tr>
<td></td>
<td>e. Resize and move the forecast chart to cover the range C2:E24.</td>
<td>e. Remove the chart title from the line chart.</td>
<td>e. Remove the chart title from the line chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>f. Resize and move the forecast chart to cover the range C2:E24.</td>
<td>f. Resize and move the forecast chart to cover the range C2:E24.</td>
</tr>
<tr>
<td>5.1</td>
<td>Switch to the Fabric Sold by Store worksheet. Create a query and load data from an Access database to display information about fabric purchased from Fabric Station stores as follows:</td>
<td>a. Create a new query that imports data from the Support_NP_EX16_11a_Fabric.accdb Access database, available for download from the SAM website.</td>
<td>a. Import data from text using the Support_NP_EX16_Mac_11a_Fabric.txt file to a new worksheet in the NP_EX16_Mac_11a_FirstLastName_2.xlsx workbook.</td>
</tr>
<tr>
<td></td>
<td>b. Preview the 2018-2019 Orders table, and then only create a connection to the data.</td>
<td>b. Start loading the data at row 1, mark the file as having headers, separate the columns using tab delimiters.</td>
<td>b. Start loading the data at row 1, mark the file as having headers, separate the columns using tab delimiters.</td>
</tr>
<tr>
<td></td>
<td>c. Add the data to the Data Model.</td>
<td>c. Load the data into a new worksheet, using Fabric Data as the name of the new worksheet.</td>
<td>c. Load the data into a new worksheet, using Fabric Data as the name of the new worksheet.</td>
</tr>
<tr>
<td></td>
<td>Create a PivotTable that shows the fabric sold by category in each of the five stores during 2018 and 2019 as follows:</td>
<td>d. Format the imported data as a table with headers using the Table Style Medium 7 table style.</td>
<td>d. Format the imported data as a table with headers using the Table Style Medium 7 table style.</td>
</tr>
<tr>
<td></td>
<td>d. In cell A3, insert a PivotTable using the workbook's Data Model.</td>
<td>e. Rename the table using Orders as the name.</td>
<td>e. Rename the table using Orders as the name.</td>
</tr>
<tr>
<td></td>
<td>e. Use the following fields from the 2018-2019 Orders table in the PivotTable areas:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>o ItemQty field: Values box</td>
<td>o Category field: Rows box</td>
<td>o Category field: Rows box</td>
</tr>
<tr>
<td></td>
<td>o StoreCity field: Columns box</td>
<td>o StoreCity field: Columns box</td>
<td>o StoreCity field: Columns box</td>
</tr>
<tr>
<td>6.1</td>
<td>Format the PivotTable to make the data easier to interpret as follows:</td>
<td>Switch to the Fabric Sold by Store worksheet. Create a PivotTable that shows the fabric sold by category in each of the five stores during 2018 and 2019 as follows:</td>
<td>Use table for PivotTable instead of Data Model</td>
</tr>
<tr>
<td></td>
<td>a. Use Items Sold as the custom name of the Sum of ItemQty field.</td>
<td>a. In cell A3, insert a PivotTable based on the Orders table you just created.</td>
<td>Loading to Data Model not available on Mac</td>
</tr>
<tr>
<td></td>
<td>b. Format the Sum of ItemQty values using the Number format with 0 decimal places and a 1000 separator.</td>
<td>b. Use the following fields from the Orders table in the PivotTable areas:</td>
<td>b. Use the following fields from the Orders table in the PivotTable areas:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o Category field: Rows box</td>
<td>o Category field: Rows box</td>
</tr>
<tr>
<td></td>
<td></td>
<td>o StoreCity field: Columns box</td>
<td>o StoreCity field: Columns box</td>
</tr>
</tbody>
</table>

© 2018 Cengage Learning / Revised January 2018
8. Switch to the Fabric Sold by Date worksheet. Create a PivotTable as follows that shows each category of fabric sold by date:
   a. In cell A3, insert a PivotTable using the workbook’s Data Model.
   b. Use the following fields from the 2018-2019 Orders table in the PivotTable areas:
      o OrderDate field: Rows box
      o ItemQty field: Values box
      o Category field: Columns box
   c. Insert a Slicer to show items sold in January as follows:
      a. Insert a Slicer that uses the OrderDate field from the Orders table.
      b. Move and resize the Slicer to cover the range I3:K16.
      c. Use the Slicer to display items sold only in January.

9. Create hierarchies for the order dates and product categories as follows so you can easily find information about a specific fabric sale on any date:
   a. Use the Manage option on the Power Pivot tab to display the Data Model in Diagram View.
   b. Create a new hierarchy and use Date as the hierarchy name.
   c. Add the OrderDate(Year), OrderDate(Quarter), OrderDate(Month) and OrderDate fields in that order to the new Date hierarchy. (Hint: Do not select the OrderDate(Month Index) field.)
   d. Create another new hierarchy and use Product as the hierarchy name.
   e. Add the Category and Subcategory fields in that order to the new Product hierarchy, and close the Power Pivot window.
   f. Revise the PivotTable to use the hierarchies you created as follows:
      g. Use the following hierarchies from the 2018-2019 Orders table in the PivotTable areas:
         o Date hierarchy: Rows box
         o Product hierarchy: Columns box
      h. Leave the ItemQty field in the Values box.

11. Use Drill Down to display the daily sales for January, 2019.

---

**New Perspectives Excel 2016 Module 11: SAM Project 1b**

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td></td>
<td></td>
<td>Uses slicer instead of timeline slicer No timeline slicer available on Mac</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td>PivotTable doesn't use hierarchies Power BI not on Mac</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td>Uses Expand Field instead of Drill Down Drill Down not on Mac</td>
</tr>
</tbody>
</table>
| 1 | Intelligence (BI) tools.  
Switch to the Sales History worksheet.  
Use Power Query to create a query and load data from a CSV file into a new table as follows:  
a. Create a new query that imports data from the Support_NP_EX16_11b_Sales.csv file, available for download from the SAM website.  
b. Edit the query to remove the Units Sold and Notes columns, then close and load the query data to a table in cell A2 of the existing worksheet. (Hint: Use the Close & Load to... button.) | Switch to the Sales History worksheet.  
Import the data from a CSV file into a new table as follows:  
a. Import data from text using the Support_NP_EX16_Mac_11b_Sales.csv file.  
b. Start loading the data at row 1, mark the file as having headers, and separate the columns using comma delimiters.  
c. Edit the data to remove the Units Sold and Notes columns, and load the data into cell A2 of the existing worksheet.  
d. Format the imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.)  
e. Use AutoFit to change the width of columns A through C. | Imported data from text instead of using Power Query  
Power BI not on Mac |
|---|---|---|---|
| 2 | Switch to the Current Sales worksheet.  
Use Power Query as follows to create a query that loads daily sales data from a CSV file and transforms the data to display only monthly totals:  
a. Beginning in cell A2, create a new query that imports data from the Support_NP_EX16_11b_Two_Years.csv file, available for download from the SAM website.  
b. Remove all columns except the OrderDate and Sales columns.  
c. Based on the OrderDate column, add a new Date column to the query using the End of Month option. (Hint: Select the OrderDate column before selecting options on the Add Column tab.)  
d. Use Month as the name of the new column.  
To display the total sales for each month, group the dates in the Month column and create a new column displaying the sum of the Sales values as follows:  
e. Transform the data in the Month column by grouping the data by month.  
f. Use Sales per Month as the name of the new column.  
g. Use Sum as the operation.  
h. Use Sales as the column to sum within the Month group.  
i. Load the query data to a table in the existing worksheet beginning in cell A2.  
j. Format the data in the range B3:B26 using the Currency number format with 2 decimal places and the $ symbol. | Switch to the Current Sales worksheet.  
Load the monthly sales data from a CSV file as follows:  
a. Import data from text using the Support_NP_EX16_Mac_11b_Two_Years.csv file.  
b. Start loading the data at row 1, mark the file as having headers, and separate the columns using comma delimiters.  
c. Edit the data to remove all columns except the Month and Monthly Sales columns, and load the data into cell A2 of the existing worksheet.  
d. Format the imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.)  
e. Format the data in the range B3:B26 using the Currency number format with 2 decimal places and the $ symbol.  
f. Use AutoFit to change the width of column B. | Imported data from text instead of using Power Query  
Power BI not on Mac |
| 4 | Create a forecasting chart to track the changes in monthly sales and project next year's monthly sales as follows:  
   a. Rename the Sheet4 worksheet using Monthly Sales Forecasts as the new name of the sheet.  
   b. Fill the range A26:E26 to the range C27:E37.  
   c. Based on the data in the range A1:E37, create a Line chart.  
   d. Based on the data in the range A1:E37, create a Line chart.  
   e. Remove the chart title from the line chart.  
   f. Resize and move the forecast chart to cover the range C2:E25. | Create a forecast sheet to track the changes in monthly sales and project next year's monthly sales as follows:  
   a. Based on the data in the range A2:B26, create a forecast sheet.  
   b. Using the Options menu in the Create Forecast Worksheet dialog box, manually set the seasonality to 12.  
   c. Use 12/31/2020 as the Forecast End date. (Hint: After clicking the Create button, click the Got it! button if the FORECAST SHEET dialog box opens.)  
   d. Use Monthly Sales Forecast as the name of the new sheet.  
   e. Resize and move the forecast chart so that the upper left corner is within cell C2 and the lower right corner is within cell E25. | Changed Forecast sheet to create your own forecasting chart using a clustered column chart.  
   Forecast sheets not on Mac. |

| 5 | Load data from a text file to display information about products purchased from JM Office Supply stores as follows:  
   a. Import data from text using the Support_NP_EX16_Mac_11b_Office.txt file to a new worksheet in the NP_EX16_Mac_11b_FirstLastname_2.xlsx workbook.  
   b. Start loading the data at row 1, mark the file as having headers, and separate the columns using tab delimiters.  
   c. Load the data into a new worksheet, using Product Data as the name of the new worksheet.  
   d. Format the imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.)  
   e. Rename the table using Products as the name. | Switch to the Products Sold by Store worksheet. Create a query and load data from an Access database to display information about products purchased from JM Office Supply stores as follows:  
   b. Preview the 2018 and 2019 Orders table, and then only create a connection to the data. (Hint: Use the Load To... button arrow to open the Load To... dialog box.)  
   c. Add the data to the Data Model.  
   d. In cell A2, insert a PivotTable using the workbook's Data Model.  
   e. Use the following fields from the 2018 and 2019 Orders table in the PivotTable areas:  
      o ItemQty field: Values box  
      o Category field: Rows box  
      o StoreCity field: Columns box | Imported data from text instead of from a database file using Power Query, step 5 split into 2 parts.  
   Power BI not on Mac, Access not on Mac. |

| 6 | Format the PivotTable to make the data easier to interpret as follows:  
   a. Use Items Sold as the custom name of the Sum of ItemQty field.  
   b. Format the Sum of ItemQty values using the Number format with 0 decimal places and a 1000 separator. | Format the PivotTable to make the data easier to interpret as follows:  
   a. Use Items Sold as the custom name of the Sum of ItemQty field.  
   b. Format the Sum of ItemQty values using the Number format with 0 decimal places and a 1000 separator. | Use table for PivotTable instead of Data Model.  
   Loading to Data Model not available on Mac. |
8. Switch to the Products Sold by Date worksheet. Create a PivotTable as follows that shows each category of product sold by date:
   a. In cell A2, insert a PivotTable using the workbook's Data Model.
   b. Use the following fields from the 2018 and 2019 Orders table in the PivotTable areas:
      o OrderDate field: Rows box
      o ItemQty field: Values box
      o Category field: Columns box

   Insert a Slicer to show items sold in March as follows:
   a. Insert a Slicer that uses the OrderDate field from the Products table.
   b. Move and resize the Slicer to cover the range I3:K16.
   c. Use the Slicer to display items sold only in March.

9. Create hierarchies for the order dates and product categories as follows so you can easily find information about a specific product sale on any date:
   a. Use the Manage option on the Power Pivot tab to display the Data Model in Diagram View.
   b. Create a new hierarchy and use Date as the hierarchy name.
   c. Add the OrderDate(Year), OrderDate(Quarter), OrderDate(Month) and OrderDate fields in that order to the new Date hierarchy. (Hint: Do not select the OrderDate(Month Index) field.)
   d. Create another new hierarchy and use Product as the hierarchy name.
   e. Add the Category and Description fields in that order to the new Product hierarchy, and close the Power Pivot window.

   Revise the PivotTable to use the hierarchies you created as follows:
   f. Remove the fields from the Columns and Rows boxes.
   g. Use the following hierarchies from the 2018 and 2019 Orders table in the PivotTable areas:
      o Date hierarchy: Rows box
      o Product hierarchy: Columns box
   h. Leave the Sum of ItemQty field in the Values box.

   Switch to the Products Sold by Date worksheet. Create a PivotTable as follows that shows each category of product sold by date:
   a. In cell A2, insert a PivotTable based on the Products table you created.
   b. Add the following fields in order from the Products table in the PivotTable areas:
      o OrderDate field: Rows box (Hint: After adding the OrderDate field, the Rows box will automatically be populated with the Years and Quarter fields.)
      o Category field: Columns box
      o ItemQty field: Values box

11. Use Drill Down to display the daily sales for March, 2019.

   Use Expand Field to display sales for each of the quarters in 2018 and 2019.
### New Perspectives Excel 2016 Module 12: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Use the Compare and Merge Workbooks feature to include comments and changes from reviewers as follows:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Merge the Support_NP_EX16_12a_Wilson.xlsx workbook, available from the SAM website, into the NP_EX16_12a_FirstLastName_2.xlsx workbook.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Merge the Support_NP_EX16_12a_Yang.xlsx workbook, available from the SAM website, into the NP_EX16_12a_FirstLastName_2.xlsx workbook.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11/10 Delete the hidden worksheet named Notes from the workbook. (Hint: If you use the Document Inspector, do not delete the document properties or personal information from the workbook.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12/11 Add the following document properties to the workbook:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Title: HME Tour Invoices</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Tags: Invoices, Tickets, Customers (Hint: This field might also be called “Keywords”, depending on how you access the document properties of the workbook.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Comments: Final review draft of the workbook for generating invoices</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. Status: Final Review Draft</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14 Mark the workbook as Final.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### New Perspectives Excel 2016 Module 12: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Use the Compare and Merge Workbooks feature to include comments and changes from reviewers as follows:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Merge the Support_NP_EX16_12b_Neale.xlsx workbook, available from the SAM website, into the NP_EX16_12b_FirstLastName_2.xlsx workbook.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Merge the Support_NP_EX16_12b_Malina.xlsx</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2018 Cengage Learning / Revised January 2018
**New Perspectives Excel 2016 Modules 9-11: SAM Capstone Project 1a**

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Use the Compare and Merge Workbooks feature to include comments and changes from Alex Mora by merging the Support_NP_EX16_CS9-12a_Mora.xlsx workbook, available from the SAM website, into the NP_EX16_CS9-12a_FirstLastName_2.xlsx workbook.</td>
<td>Switch to the Home worksheet. Review and respond to the comments in the workbook as follows: a. Respond to the comment from Alex Mora in cell D6 by changing the value in cell D6 as Alex requests. b. Delete the comment in cell D6. c. Review the next comment in the workbook, which is from Alex Mora in cell D12. Edit the comment by including Yes as the response.</td>
<td>Support file pre-merged Compare and merge not available on Mac</td>
</tr>
<tr>
<td></td>
<td>2. Switch to the Home worksheet. Review and respond to the comments in the workbook as follows: a. Respond to the comment from Alex Mora in cell D6 by changing the value in cell D6 as Alex requests. b. Delete the comment in cell D6. c. Review the next comment in the workbook, which is from Alex Mora in cell D12. Edit the comment by including Yes as the response.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Mark the workbook as Final.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 30 | Sarah asks you to produce a sales report for all products sold in five regions since the company was founded in 1979, and then to project future sales. To create the report, you need to import data from various sources and use the Excel Business Intelligence (BI) tools. Switch to the Sales History worksheet. Use Power Query to create a query and load data from a CSV file into a new table as follows:  
   a. Create a new query that imports data from the Support_NP_EX16_CS9-12a_History.csv file, available for download from the SAM website.  
   b. Edit the query to remove the Units Sold column, then close and load the query data to a table in cell A3 of the existing worksheet. (Hint: Use the Close & Load to... button.) | Insert a chart to identify trends in the sales history data as follows:  
   a. Insert a Scatter chart based on the values in the range B3:C24.  
   b. Move and resize the chart so that it covers the range D3:J20.  
   c. Add the axis title Sales ($mil) to the vertical axis.  
   d. Use Sales Trend as the chart title.  
   e. Add a Logarithmic trendline to the chart. | Imported data from text instead of using Power Query. Power BI not on Mac. |
| 32 | Switch to the Monthly Sales worksheet. Use Power Query as follows to create a query that loads sales data from a CSV file containing daily orders from the past two years and transforms the data to display only monthly totals:  
   b. Edit the query to remove all columns except the OrderDate and Sales columns.  
   c. Based on the OrderDate column, add a new Date column to the query using the End of Month option. (Hint: Select the OrderDate column before selecting options on the Add Column tab.)  
   d. Use Month as the name of the new column.  
   To display the total sales for each month, group the dates in the Month | Go to the Sheet4 worksheet. Create a forecasting chart sheet to track the changes in monthly sales and project next year's monthly sales as follows:  
   a. Rename the Sheet4 worksheet using Monthly Sales Forecasts as the new name of the sheet.  
   b. Fill the range A26:A37 with the last day of each month in 2020.  
   c. Copy the formula from the range C26:E26 to the range C27:E37.  
   d. Based on the data in the range A1:E37, create a Line chart.  
   e. Remove the chart title from the line chart.  
   f. Resize and move the forecast chart to cover the range C2:E25. | Imported data from text instead of using Power Query. Changed columns used instead of adding Date column. Power BI not on Mac. |
| 33 | Create a forecast sheet to track the changes in monthly sales and project next year's monthly sales as follows: a. Based on the data in the range A3:B27, create a forecast sheet. b. Using the Options menu in the Create Forecast Worksheet dialog box, manually set the seasonality to 12. c. Use 12/31/2020 as the Forecast End date. (Hint: After clicking the Create button, click the Got it! button if the FORECAST SHEET dialog box opens.) d. Use Monthly Sales Forecasts as the name of the new sheet. e. Resize and move the forecast chart to cover the range C2:E25. | Load data from a CSV file to display sales information by month and region as follows: a. Import data from text using the Support_NP_EX16_Mac_CS9-12a_Sales.csv file to a new worksheet in the NP_EX16_Mac_CS9-12a_FirstLastName_2.xlsx workbook. b. Start loading the data at row 1, mark the file as having headers, separate the columns using comma delimiters. c. Load the data into a new worksheet, using Order Data as the name of the new worksheet. d. Format the imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.) e. Rename the table using Orders as the name. | Changed Forecast sheet to create your own forecasting chart using a clustered column chart Forecast sheets not on Mac |
| 34 | Switch to the Products Sold by Location worksheet. Create another query and load data from a CSV file to display sales information by month and region as follows: a. Create a new query that imports data from the Support_NP_EX16_CS9-11a_Sales.csv file, available for download from the SAM website. b. Preview the Orders worksheet, and then only create a connection to the data. (Hint: Use the Load To button arrow to open the Load To dialog box.) c. Add the data to the Data Model. Create a PivotTable that shows products sold in each of five regions during 2018 and 2019 as follows: | Switch to the Products Sold by Location worksheet. Create a PivotTable that shows products sold in each of five regions during 2018 and 2019 as follows: a. In cell A3, insert a PivotTable based on the Orders table you created. b. Add the following fields in order from the Orders table in the PivotTable areas: o OrderDate field: Rows box o Region field: Columns box o Units field: Values box | Imported data from text instead of using Power Query, no creating only a connection to the data model Power BI not on Mac |
**New Perspectives PowerPoint 2016**

**New Perspectives PowerPoint 2016 Module 4: SAM Project 1a**

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 3    | With Slide 1 still displaying, customize the theme colors to change the hyperlink colors as follows:  
   a. Change the Hyperlink color to Turquoise, Accent 2 (6th column, 1st row of the Theme Colors palette).  
   b. Change the Followed Hyperlink color to Blue-Gray, Text 2, Lighter 40% (4th column, 4th row of the Theme Colors palette). | With Slide 1 still displaying, customize the theme colors to change the hyperlink colors as follows:  
   a. Change the Hyperlink color to 3399CC (With the Design Tab selected choose Colors; click Customize Colors...; click the Hyperlink color box; choose the Color Palettes option from the top of the Colors box; select Web Safe Colors from the drop-down; and then enter the color number).  
   b. Change the Followed Hyperlink color to 999999 (With the Design Tab selected choose Colors; click Customize Colors...; click the Followed Hyperlink color box; choose the Color Palettes option from the top of the Colors box; select Web Safe Colors from the drop-down; and then enter the color number). | Uses slicer instead of timeline slicer  
No timeline slicer available on Mac |
<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>With Slide 1 still displaying, customize the theme colors to change the hyperlink colors as follows:</td>
<td></td>
<td>Removed.</td>
</tr>
<tr>
<td></td>
<td>a. Change the Hyperlink color to Dark Purple, Accent 2 (6th column, 1st row of the Theme Colors palette).</td>
<td></td>
<td>Triggers not available in PowerPoint 2016 for MacOS.</td>
</tr>
<tr>
<td></td>
<td>b. Change the Followed Hyperlink color to Light Turquoise, Text 2 (4th column, 1st row of the Theme Colors palette).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4b</td>
<td>Drag the motion path ending point (red triangle) so that the ending point is even with the 3&quot; mark on the horizontal ruler, as shown in Figure 1 below. (Hint: Only move the end point of the motion path. If you accidentally drag any other point on the motion path, press CTRL+Z to undo that action and try again.)</td>
<td>Drag the motion path ending point (red triangle) so that the ending point is even with the 3&quot; mark on the horizontal ruler, as shown in Figure 1 below. (Hint: Only move the end point of the motion path. If you accidentally drag any other point on the motion path, press command +Z to undo that action and try again.)</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>On Slide 4 (“SYSTEM PRICING”), add animation triggers as follows:</td>
<td>Removed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Select the three black shapes, and then apply the Wipe Entrance animation to them. (Hint: Select the shapes containing text $400, $1000 and $3000+.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Make each shape a trigger for its respective button. Make the Entry PUSH button the trigger for the $400 shape.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Make the Mid-Level PUSH button the trigger for the $1000 shape.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. Make the Premium PUSH button the trigger for the $3000+ shape.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7/6</td>
<td>On Slide 5 (“BASIC QUESTIONS”), add animation to the key picture as follows:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Apply the Arcs Motion Path animation to the key picture.</td>
<td>a. Apply the Arc Basic Path animation to the key picture.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Change the direction of the animation to Right.</td>
<td>b. Change the direction of the animation to Right.</td>
<td></td>
</tr>
<tr>
<td>10/9</td>
<td>Set the Transitions Advance Slide timing for all slides to After 00.04.00.</td>
<td>Set the Transitions Advance Slide timing for all slides to After 04.00.</td>
<td></td>
</tr>
<tr>
<td>11/10</td>
<td>On Slide 4 (“SYSTEM PRICING”) only, set the Transitions Advance Slide timing to After 00.06.00.</td>
<td>On Slide 4 (“SYSTEM PRICING”) only, set the Transitions Advance Slide timing to After 06.00.</td>
<td></td>
</tr>
</tbody>
</table>
Followed Hyperlink color box; choose the Color Palettes option from the top of the Colors box; select Web Safe Colors from the drop-down; and then enter the color number).

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>4b</td>
<td>Drag the motion path ending point (red triangle) so that the ending point is even with the 3” mark on the horizontal ruler, as shown in Figure 1 below. (Hint: Only move the end point of the motion path. If you accidentally drag any other point on the motion path, press CTRL+Z to undo that action and try again.)</td>
</tr>
</tbody>
</table>
| 6 | On Slide 4 (“VIDEO CARD PRICING”), add animation triggers as follows:  
   a. Select the three black shapes, and then apply the Fly In Entrance animation to them. (Hint: Select the black shapes containing text $100, $400, and $700+, but not the target pictures.)  
   b. Make each target picture a trigger for its respective button.  
      i. Make the Basic purple target the trigger for the $100 shape.  
      ii. Make the Mid-Range blue target the trigger for the $400 shape.  
      iii. Make the High-End green target the trigger for the $700+ shape. |
| 7/6 | On Slide 5 (“BASIC QUESTIONS”), apply animation to the road picture as follows:  
   a. Apply the Lines Motion Path animation to the road picture.  
   b. Change the direction of the animation to Up. |
| 10/9 | Set the Transitions Advance Slide timing for all slides to After 00:6.00. |
| 11/10 | On Slide 4 (“VIDEO CARD PRICING”) only, set the Transitions Advance Slide timing to After 00:8.00. |

New Perspectives PowerPoint 2016 Module 6: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>You are the new marketing director for Outdoor Eating Apps, part of the Galactic Food Blog Network. You want to introduce a regular series on apps serving picnic.</td>
<td>You are the new marketing director for Outdoor Eating Apps, part of the Galactic Food Blog Network. You want to introduce a regular series on apps serving picnic.</td>
<td>Compare and reject/accept changes not available in PowerPoint 2016 for MacOS.</td>
</tr>
</tbody>
</table>
lovers and the outdoor eating enthusiast community. After sending out the presentation for review, you are ready to tailor the presentation to your discerning audience. Compare two presentations, then select the file Support_NP_PPT16_6a_Apps-Review.pptx available for download from the SAM website to merge with the current presentation. Show the Revisions pane and the Comments pane, if necessary.

<table>
<thead>
<tr>
<th>2</th>
<th>Customize the presentation as follows:</th>
<th>Customize the presentation as follows:</th>
<th>Creating theme font not available in PowerPoint 2016 for MacOS.</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Change the presentation theme colors to Aspect.</td>
<td>a. Change the presentation theme colors to Aspect.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. Change the theme fonts to Candara.</td>
<td>b. Change the theme fonts to Candara.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>c. Create a new theme font with Century Gothic as the body font.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>d. Name the new theme font FoodApp. (Hint: Do not type the period.)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| 4d | Change the fill color of the title placeholder to Dark Gray, Text 2, Lighter 10% (4th column, 6th row in the Theme Colors palette). | Change the fill color of the title placeholder to Gray-80%, Text 2, Lighter 10% (4th column, 6th row in the Theme Colors palette). | |

| 7 | Change Info properties in Backstage view as follows: | Change the Subject text to: Summer Reviews (Hint – Click File, Click Properties, select Summary, Status property, marking presentation as final not available in PowerPoint 2016 for MacOS. | |
| a. Change the Status text to: Draft 2 | | | |
b. Change the Subject text to: Summer Reviews and enter text in the Subject: text box.
c. Mark the presentation as final.

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Onward Luggage specializes in shipping lost and specialty luggage. You are helping them gain market dominance in convention and conference deliveries. This presentation combines all of Onward Luggage's services. After receiving review comments, you finalize the presentation for the sales department. Compare two presentations, then select the file Support_NP_PPT16_6b_Luggage-Review.pptx available for download from the SAM website to merge with the current presentation. Show the Revisions pane and the Comments pane, if necessary.</td>
<td>Onward Luggage specializes in shipping lost and specialty luggage. You are helping them gain market dominance in convention and conference deliveries. This presentation combines all of Onward Luggage's services. After receiving review comments, you finalize the presentation for the sales department.</td>
<td>Compare and reject/accept changes not available in PowerPoint 2016 for MacOS.</td>
</tr>
<tr>
<td></td>
<td>a. On Slide 1 (“Onward Luggage”), reject the text change to the subtitle placeholder.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. On Slide 2 (“We Know Luggage Shipping”), reply to the comment by typing: Both parties split our fee.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. On Slide 3 (“We Reunite Passengers and Luggage”), accept the text change to the content placeholder.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. With Slide 3 still displaying, add a comment by typing: Excellent visual. (Hint: Include the period.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>e. On Slide 5 (“Is It Really Convenient?”), delete the comment.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>f. On Slide 6 (“Shipping Hacks”), delete the comment.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>g. With Slide 6 still displaying, change the text in the first bullet “hotel” to: destination</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>h. Close the Revisions pane and the Comments pane.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Customize the presentation as follows:</td>
<td>Customize the presentation as follows:</td>
<td>Creating theme font not available in PowerPoint 2016 for MacOS.</td>
</tr>
<tr>
<td></td>
<td>a. Change the presentation theme colors to Violet.</td>
<td>a. Change the presentation theme colors to Violet.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Change the theme fonts to Corbel.</td>
<td>b. Change the theme fonts to Corbel.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Create a new theme font with Century Gothic as the body font.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2018 Cengage Learning / Revised January 2018
### New Perspectives PowerPoint 2016 Modules 3-4: SAM Capstone Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Change Info properties in Backstage view as follows: &lt;br&gt; a. Change the Status text to: After Comments  &lt;br&gt; b. Change the Subject text to: Conference Outreach  &lt;br&gt; c. Mark the presentation as final.</td>
<td>Change the Subject text to: Conference Outreach (Hint – Click File, Click Properties, select Summary, and enter text in the Subject: text box.)</td>
<td>Status property, marking presentation as final not available in PowerPoint 2016 for MacOS.</td>
</tr>
</tbody>
</table>

| 1a   | Apply the Teeter Emphasis animation to the drinks picture. | Apply the Teeter Moderate animation to the drinks picture. (Hint: Teeter Moderate animation is present in the Emphasis Effects category.) |

| 3    | With Slide 2 still displaying, customize the theme colors to change the hyperlink colors as follows: <br> a. Change the Hyperlink color to Blue, Hyperlink Darker 25% (11<sup>th</sup> column, 5<sup>th</sup> row of the Theme Colors palette).  <br> b. Change the Followed Hyperlink color to Gray-25%, Text 2, Darker 50% (4<sup>th</sup> column, 4<sup>th</sup> row of the Theme Colors palette). (Hint: Depending on your version of office, the color name may display as Light Gray, Text 2, Darker 50% instead.) | On Slide 2, customize the theme colors to change the hyperlink colors as follows:  <br> a. Change the Hyperlink color to 333333 (With the Design Tab selected choose Colors; click Customize Colors...; click the Hyperlink color box; choose the Color Palettes option from the top of the Colors box; select Web Safe Colors from the drop-down; and then enter the color number).  <br> b. Change the Followed Hyperlink color to 666666 (With the Design Tab selected choose Colors; click Customize Colors...; click the Followed Hyperlink color box; choose the Color Palettes option from the top of the Colors box; select Web Safe Colors from the drop-down; and then enter the color number). |

<p>| 13a  | Insert the Action Button: Home action button. (Hint: Depending on your version of office, the action button name may display as Action Button: Go Home instead.) | Insert the Home action button. |</p>
<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>14a</td>
<td>Insert WordArt using the Fill: Black, Text color 1; Outline: White, Background color 1; Hard Shadow: White, Background color 1 WordArt style (Hint: Depending on your version of office, the WordArt style may display as Fill - Black, Text 1, Outline - Background 1, Hard Shadow - Background 1 instead).</td>
<td>Insert WordArt using the Fill - Black, Text 1, Outline - Background 1, Hard Shadow - Background 1 WordArt style.</td>
<td></td>
</tr>
</tbody>
</table>
| 15   | With Slide 8 still displaying, add a trigger animation to the pictures of the drinks as follows:  
   a. Select the two bullet placeholders, and then apply the Zoom Entrance animation.  
   b. Make each drinks picture a trigger for the bullet placeholder beneath it. Make the “Sports Drinks” picture the trigger for the sports drinks bullet placeholder.  
   Make the “Energy Drinks” picture the trigger for the energy drinks bullet placeholder. | Removed. | No trigger option on MacOS. |
| 18/17| Set the Transitions Advance Slide timing for all slides to After 00:03.75. | On the Transitions tab, set the “After:” timing for all slides to 03.75. | |
| 19/18| On Slide 6 (“Our Formula for Success”) only, set the Transitions Advance Slide timing to After 00:05.00. | On Slide 6 (“Our Formula for Success”) only, set the “After:” timing to 05.00. | |

**New Perspectives PowerPoint 2016 Modules 5-6: SAM Capstone Project 1a**

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Compare two presentations, then select the file Support_NP_PPT16_CS5-6a_Shade-Review.pptx available for download from the SAM website to merge with the current presentation. (Hint: Do not accept changes to the slides notes on Slide 1.) Show the Comments pane, if necessary.</td>
<td>Removed compare and merge part.</td>
<td>Not available on MacOS. The start file has been updated with the Compare and Merge.</td>
</tr>
</tbody>
</table>
| 2    | Customize the presentation as follows:  
   a. Change the presentation theme colors to Marquee.  
   b. Create a new custom theme font with Candara as the Heading font.  
   c. Change the Body font to Franklin Gothic Medium.  
   d. Name the new theme font Shade.  
   (Hint: Do not include the period.) | Customize the presentation by changing the presentation theme colors to Marquee. | |
| 5b   | Copy the chart and then paste it on Slide 2 using the destination theme and link data | Copy the chart and then paste it on Slide 2 using the destination theme and link | |
so that you can update the original with the latest data.

data so that you can update the original with the latest data. (Hint: A Grant File Access dialog box may open. If this occurs, click Select..., and then click Grant Access.)

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>9a</td>
<td>Resize the worksheet to a height of 2.4&quot;. The width will automatically resize to approximately 4.67&quot;.</td>
<td>Resize the worksheet to a height of 2.4&quot;. The width will automatically resize to approximately 5.33&quot;.</td>
<td></td>
</tr>
</tbody>
</table>
| 14   | Finalize the presentation as follows:  
   a. Change the Status document property to: Final Pending  
   b. Change the Subject document property to: Franchise  
   c. Mark the presentation as final. | Change the Subject document property to: Franchise (Hint – Click File, Click Properties, select Summary, and enter text in the Subject: text box.) | |

New Perspectives Word 2016

New Perspectives Word 2016 Module 2: SAM Project 1a

Insert a header to meet MLA standards as follows:
   a. From the Top of Page page number gallery, insert a Plain Number 3 page number to the header of all pages in the document.  
   b. Without moving your insertion point, type Cooper and then press the Spacebar.  
   c. Close the Header & Footer Tools.

Create a header to meet MLA standards as follows:
   a. Insert a Top of page (Header) page number with Right alignment all pages in the document.  
   b. Edit the header, type Cooper and then close the Header and Footer area.

Reworded instructions
Menu options to insert headers differ on Mac

Find the paragraph beginning “Three technologies are required...” Move the insertion point before the colon and insert a citation from a new source using the information shown in Table 1 on the next page.

Sources created in Word for Mac cannot be graded accurately due to how they are stored in the file.

In the same paragraph, move the insertion point before the period

Sources created in Word for Mac cannot be graded accurately due to how they are stored in the file.

© 2018 Cengage Learning / Revised January 2018
in the sentence “The idea behind platooning...according to an article in Science News.” Insert a citation that creates a new source with the information shown in Table 2 below.

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Move the insertion point before the period in the sentence you modified in the previous step (“The cost of the new technology...for most car owners.”), and then insert a citation to the existing Fagnant, Daniel and Kockelman, Kara source.</td>
<td>step removed</td>
<td>step removed Sources and citations created in Word for Mac cannot be graded accurately due to how they are stored in the file</td>
</tr>
</tbody>
</table>

New Perspectives Word 2016 Module 2: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Insert a header to meet MLA standards as follows: a. From the Top of Page page number gallery, insert a Plain Number 3 page number to the header of all pages in the document. b. Without moving your insertion point, type Hill and then press the Spacebar. c. Close the Header &amp; Footer Tools.</td>
<td>Insert a header to meet MLA standards as follows: a. Insert a Top of page (Header) page number with Right alignment all pages in the document. b. Edit the header, type Hill and then close the Header and Footer area.</td>
<td>Reworked instructions Menu options to insert headers differ on Mac</td>
</tr>
<tr>
<td>7</td>
<td>Find the sentence beginning “Physicists now call this antigravity force....” Move the insertion point before the period at the end of the sentence and insert a citation from a new source using the information shown in Table 1 below.</td>
<td>step removed</td>
<td>step removed Sources created in Word for Mac cannot be graded accurately due to how they are stored in the file</td>
</tr>
<tr>
<td>11</td>
<td>In the paragraph beginning “While trying to understand...,” move the insertion point before the period at the end of the paragraph. Insert a citation that creates a new source with the information shown in Table 2 below.</td>
<td>step removed</td>
<td>step removed Sources created in Word for Mac cannot be graded accurately due to how they are stored in the file</td>
</tr>
<tr>
<td>13</td>
<td>Move the insertion point before the period in the sentence you modified in the previous step (“Furthermore, of the invisible...force or substance.”),</td>
<td>step removed</td>
<td>step removed Sources and citations created in Word for Mac cannot be graded accurately due to how they are stored in the file</td>
</tr>
</tbody>
</table>
and then insert a citation to the existing Merali, Zeeya source.

New Perspectives Word 2016 Module 4: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 1    | As a member of the Missouri Memorial Hospital Auction Committee, you are adding and formatting graphics in a letter and handout for committee members. Start by formatting the Auction graphic on page 1 as follows:  
   a. Apply the correction Brightness: 0% (Normal) Contrast: +20% to the graphic.  
   b. Position the graphic using the Top Right with Square Text Wrapping option.  
   c. Apply the Reflected Rounded Rectangle picture style. | As a member of the Missouri Memorial Hospital Auction Committee, you are adding and formatting graphics in a letter and handout for committee members. Start by formatting the Auction graphic on page 1 as follows:  
   a. Apply the correction Brightness: 0% (Normal) Contrast: +20% to the graphic.  
   b. Position the graphic using the Position in Top Right option.  
   c. Apply the Reflected Rounded Rectangle picture style. | Position in Top Right with Square Text Wrapping modified to Position in Top Right  
Position in Top Right with Square Text wrapping not an option on Mac |
| 9    | On page 4, to draw attention to information about a previous auction, insert and format a sidebar text box as follows:  
   a. Move the insertion point anywhere in the heading “Donations”, and then insert a Facet Sidebar (Left) text box.  
   b. Use Auction 2019 by the numbers as the Sidebar Title.  
   c. Insert text from the file Support_NP_WD16_4a_Numbers.docx, available for download from the SAM website, to replace the remaining placeholder text in the sidebar. (Hint: Insert the text from the file; do not copy and paste the text from the file.)  
   d. Resize the entire sidebar to a height of 6.3". | On page 4, to call attention to information about a previous auction, draw a text box as follows:  
   a. Draw a text box to the left of the heading “Donations”.  
   b. Resize the text box to a height of 6.3" and a width of 3.25".  
   c. Type Auction 2019 by the numbers as the text box title, and then press ENTER.  
   d. Format the title text using 16 pt. Bookman Old Style font and the Pink, Accent 1 font color (5th column, 1st row in the Theme Colors palette).  
   e. In the blank paragraph below the title, insert text from the file Support_NP_WD16_Mac_4a_Numbers.docx, available for download from the SAM website. (Hint: Insert the text from the file; do not copy and paste the text from the file.) | Changed preformatted side bar text box to regular text box.  
Added instruction to manually format title text to approximate effect of preformatted text box.  
Preformatted text boxes not available on Mac |
| 10   | On page 4, draw and format a text box as follows:  
   a. Draw a text box to the left of the heading “Missouri Memorial Hospital”.  
   b. Resize the text box to a height of 2.8" and a width of 2.5". | On page 4, draw and format a second text box as follows:  
   a. Draw a text box to the left of the heading “Missouri Memorial Hospital”.  
   b. Resize the text box to a height of 2.8" and a width of 2.5".  
   c. Copy and paste the text in the document. | Changed instruction to format text box using Bottom Left with Square Text Wrapping option to moving the floating object as shown in Figure 2.  
Reorganized step for clarity. |
c. Position the text box using the Bottom Left with Square Text Wrapping option.
d. Copy and paste the text in the document Support_NP_WD16_4a_Wing.docx, available for download from the SAM website, into the new text box.
e. Apply the Colored Fill – Pink, Accent 1 shape style (2nd column in the Shape Style gallery).
f. Apply the Offset Diagonal Bottom Right shape effect from the Outer section of the Shadow shape effects gallery. (Hint: Depending on your version of Office, the shape effect may display as Offset: Bottom Right instead.)

New Perspectives Word 2016 Module 4: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 1    | Flanagan Software is planning its annual company getaway. As a project assistant, you are adding and formatting graphics in an information packet for employees. Start by formatting the stylized “F” picture on page 1 as follows:  
a. Apply the correction Brightness: +40% Contrast: -20% to the picture.  
b. Position the graphic using the Top Right with Square Text Wrapping option.  
c. Apply the Bevel Perspective Left, White picture style. | Flanagan Software is planning its annual company getaway. As a project assistant, you are adding and formatting graphics in an information packet for employees. Start by formatting the stylized “F” picture on page 1 as follows:  
a. Apply the correction Brightness: +40% Contrast: -20% to the picture.  
b. Position the graphic using the Position in Top Right option.  
c. Apply the Bevel Perspective Left, White picture style. | Position in Top Right with Square Text Wrapping modified to Position in Top Right Position in Top Right with Square Text wrapping not an option on Mac |
| 9    | On page 4, to provide additional information about the accommodations, insert and format a sidebar text box as follows:  
a. Move the insertion point anywhere in the heading “Lodging”, and then insert an Ion Sidebar 1 text box.  
b. Use About the Snake River Resort as the Sidebar Title.  
c. Insert text from the file Support_NP_WD16_4b_Resort.docx, available for download from the SAM website, to replace the remaining placeholder text in the | On page 4, to provide additional information about the accommodations, draw a text box as follows:  
a. Draw a text box to the left of the heading “Lodging”.  
b. Resize the text box to a height of 6.75” and a width of 2.35”.  
c. Type About the Snake River Resort as text box title, and then press ENTER.  
d. Format the title text using an 18 pt. font size and the Pink, Accent 5 font color (9th column, 1st row in the Theme Colors palette). | Changed preformatted side bar text box to regular text box. Added instruction to manually format title text to approximate effect of preformatted text box. Preformatted text boxes not available on Mac |
<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>You are creating a form letter to send to people who requested more information about Camille’s Classic Cars at a recent car show. Begin formatting the document by selecting the list of technicians and their specialties on page 1 (beginning “Glenna Warner” and ending “Engine modifications”), and then set a left tab stop at 3” using the 2 dotted line leader option.</td>
<td>You are creating a form letter to send to people who requested more information about Camille’s Classic Cars at a recent car show. Begin formatting the document by selecting the list of technicians and their specialties on page 1 (beginning “Glenna Warner” and ending “Engine modifications”), and then set a left tab stop at 3” using the 2 dotted line leader option (Hint: the first dotted line option below “none”).</td>
<td>...... Dotted line leader option rather than 2. ...... Dotted line leader specified Different leader line options available in Word for Mac</td>
</tr>
<tr>
<td>Step</td>
<td>Instructions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 6    | Start a mail merge, and then select Letters as the type of main document. Next, type a new recipient list as follows:  
  a. Customize the columns by deleting the Company Name, Country or Region, and Work Phone fields.  
  b. After the Email Address field, add a new field using Car Model as the name.  
  c. Enter the recipient information shown in bold in Table 3 below.  
  d. Save the data source using a name of your choice. |
| 8    | In the greeting line, delete "[INSERT TITLE]", and then insert the Title merge field. Next, delete "[INSERT LAST NAME]", and then insert the Last_Name merge field. |
| 9    | In the paragraph after the greeting line, delete "[INSERT CAR MODEL]", and then insert the Car_Model merge field. |
| 10   | In the paragraph that begins "Please call me..., delete "[INSERT EMAIL ADDRESS]", and then insert the Email_Address merge field. |
| 11   | Complete the mail merge as instructed in the lettered steps below. You will merge to a new document and then copy the contents of the merged file to the bottom of your original document, so that all of your assignment appears in the same file.  
  a. Finish and merge all records to a new document.  
  b. In the new document Letters1.docx, which contains the merged form letter, press CTRL+A to select all contents in the document, and then copy the merged form letter to the Office Clipboard.  
  c. In the file NP_WD16_6a_FirstLastName_2.docx, move the insertion point to the blank paragraph at the end of the document, insert a Page Break, and then paste the merged form letter into the main document. |
You are creating a form letter to send to people who requested more information about Custom Gazebos at a recent Outdoor Living trade show. Begin formatting the document by selecting the list of team members and their roles on page 1 (beginning with “Mary Kay Briggs” and ending with “Logistics”), and then set a left tab stop at 4” using the 2…… dotted line leader option (Hint: the first dotted line option below “none”).

Start a mail merge, and then select Letters as the type of main document. Next, type a new recipient list as follows:

- Customize the columns by deleting the Company Name, Country or Region, and Work Phone fields.
- After the E-mail Address field, add a new field using Product as the name.
- Enter the recipient information shown in bold in Table 3 below.
- Save the data source using a name of your choice.

In the greeting line, delete “[INSERT TITLE]”, and then insert the Title merge field. Next, select “[INSERT LAST NAME]”, and then insert the Title merge field. Next, select “LastName” rather than Last_Name field specified.
and then insert the Last_Name merge field.

"[INSERT LAST NAME]", and then insert the LastName merge field.

Different field name conventions in Word for Mac

| 10 | In the paragraph that begins “To schedule a site visit…”, delete "[INSERT EMAIL ADDRESS]", and then insert the Email_Address merge field. | In the paragraph that begins “To schedule a site visit…”, delete "[INSERT EMAIL ADDRESS]", and then insert the EmailAddress merge field. | EmailAddress rather than Email_Address field specified Different field name conventions in Word for Mac |

| 11 | Complete the mail merge as instructed in the lettered steps below. You will merge to a new document and then copy the contents of the merged file to the bottom of your original document, so that all of your assignment appears in the same file. a. Finish and merge all records to a new document. b. In the new document Letters1.docx, which contains the merged form letter, press CTRL+A to select all contents in the document, and then copy the merged form letter to the Office Clipboard. c. In the file NP_WD16_6b_FirstLastName_2.docx, move the insertion point to the blank paragraph at the end of the document, insert a Page Break, and then paste the merged form letter into the main document. d. To remove the extra blank page at the end of your main document, delete the Section Break and all but one of the blank paragraph marks. Verify that the pasted merged form letter appears on pages 3 and 4 of the file NP_WD16_6b_FirstLastName_2.docx, and then turn off the preview of the mail merge results if necessary. Close the new, merged document without saving it. |

|  | Complete the mail merge as instructed in the lettered steps below. You will merge to a new document and then copy the contents of the merged file to the bottom of your original document, so that all of your assignment appears in the same file. a. Finish and merge all records to a new document. b. In the new document Form Letters 1.docx, which contains the merged form letter, press Command+A to select all contents in the document, and then copy the merged form letter to the Office Clipboard. c. In the file NP_WD16_Mac_6b_FirstLastName_2.docx, move the insertion point to the blank paragraph at the end of the document, insert a Page Break, and then paste the merged form letter into the main document. d. To remove the extra blank page at the end of your main document, delete the Section Break and all but one of the blank paragraph marks. Verify that the pasted merged form letter appears on pages 3 and 4 of the file NP_WD16_Mac_6b_FirstLastName_2.docx, and then turn off the preview of the mail merge results if necessary. Close the new, merged document without saving it. | Command+A rather than CTRL+A specified Command button on Mac has same functionality as CTRL button on PCs |

**New Perspectives Word 2016 Module 8: SAM Project 1a**

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Using the Manage Styles button from the Styles group on the</td>
<td>Open the Tools menu, select the Templates and Add-Ins... option,</td>
<td>Tools menu pathway specified rather than Manage Styles button</td>
</tr>
<tr>
<td>Step</td>
<td>Windows</td>
<td>MacOS</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>Using the Manage Styles and Organizer dialog boxes, copy the style named Logo from the template file Support_NP_WD16_8b_Ithaca.dotx, available for download from the SAM website.</td>
<td>Open the Tools menu, select the Templates and Add-Ins option, and click the Organizer button, then copy the style named Logo from the template file Support_NP_WD16_Mac_8b_Ithaca.dotx, available for download from the SAM website.</td>
<td>Tools menu pathway specified rather than Manage Styles button Different template pathway available in Word for Mac</td>
</tr>
<tr>
<td>7</td>
<td>To the left of the “Ithaca Car Audio” text, draw a Rectangle: Rounded Corners shape 2.0” high and 3.2” wide. Vertically align the rounded rectangle shape by positioning the middle sizing handle on its left border at the 1.5” mark on the vertical ruler.</td>
<td>To the left of the “Ithaca Car Audio” text, draw a Rounded Rectangle shape 2.0” high and 3.2” wide. Vertically align the rounded rectangle shape by positioning the middle sizing handle on its left border at the 1.5” mark on the vertical ruler.</td>
<td>Rounded Rectangle shape specified rather than Rectangle: Rounded Corners Different shape names available in Word for Mac</td>
</tr>
</tbody>
</table>
10 On the Info screen in Backstage View, add Shaun Yee as the Manager property and Installation as the Subject property.  
Removed from Mac project  
Removed from Mac project Manager and Services properties not available in Word for Mac

11 After the “Questions? Contact” text in the header, insert a Quick Part using the Manager document property.  
Removed from Mac project  
Removed from Mac project Quick parts not available in Word for Mac

12 Insert a Fill-in field at the end of each paragraph listed in Table 1 below. Include a prompt for each Fill-in field as shown in bold in Table 1. Do not enter any sample text when prompted. (Hint: Click the Cancel button.)  
Removed from Mac project  
Removed from Mac project Fill-In fields not available in Word for Mac

New Perspectives Word 2016 Module 9: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 5    | In the Pool Maintenance table, press the Alt key and move a gridline to make the “How often do you use your pool?” row 0.6" high, as indicated by the measurements in the vertical ruler, so that it is approximately the same height as the two rows above it. | In the Pool Maintenance table, move a gridline to make the “How often do you use your pool?” row 0.5" high, as indicated by the measurements in the vertical ruler, so that it is approximately the same height as the two rows above it. | Row height set at 0.5" rather than 0.6"; Alt key not used  
Easier to set at 0.5" in Word for Mac; Alt key not available on Macs |
| 6    | In the Pool Maintenance table, press the Alt key and move a gridline to make Column A 1.2" wide, as indicated in the horizontal ruler. (Hint: Depending on your version of Office, the text “Chemical Fee:” and “Price Estimate:” in the bottom row may or may not wrap to a second line as shown in the Final Figure.) | In the Pool Maintenance table, move a gridline to make Column A 1.25" wide, as indicated in the horizontal ruler. (Hint: Depending on your version of Office, the text “Chemical Fee:” and “Price Estimate:” in the bottom row may or may not wrap to a second line as shown in the Final Figure.) | Column width set at 1.25" rather than 1.2"; Alt key not used  
Easier to set at 1.25" in Word for Mac; Alt key not available on Macs |
| 10   | In the Customer Information table, use the Developer tab to insert a Plain Text content control in cell B2 (the blank cell to the right of “Name:”) and format it as follows:  
a. Use Name as the title of the control.  
b. Do not allow the control to be deleted.  
c. Use Enter your name. as the placeholder text. | In the Customer Information table, use the Developer tab to insert a Text Box content control in cell B2 (the blank cell to the right of “Name:”) and format it as follows:  
a. Use Name as the title of the control.  
b. Click the Options button, then enter Enter your name. as the default text. | Text Box control rather than Plain Text control inserted; default text rather than placeholder text specified  
Limited content control options available in Word for Mac |
<table>
<thead>
<tr>
<th></th>
<th>In the Customer Information table, insert a Check Box content control next to “Monthly” and another one next to “Weekly”. Do not allow the controls to be deleted.</th>
<th>In the Customer Information table, insert a Check Box content control to the left of “Monthly” and another one to the left of “Weekly”. Be sure to insert a space between the check boxes and the text.</th>
<th>Removed instruction to not allow controls to be deleted Different functionality for locking content controls available in Word for Mac; see step 16 in Mac project</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>In the Pool Maintenance table, insert a Date Picker content control in cell B2 (the blank cell to the right of “When was your pool installed?”) and format the content control as follows: a. Use Installation Date as the title of the control. b. Do not allow the control to be deleted. c. Use M/yyyy as the date format. d. Use Click the arrow, and then click a date. as the placeholder text.</td>
<td>In the Pool Maintenance table, insert a Text Box content control in cell B2 (the blank cell to the right of “When was your pool installed?”) and format the content control as follows: a. Click Options, then Select the Date type. b. Use MMM-yy as the date format.</td>
<td>Text Box control with Date formatting rather than Date Picker inserted Date Picker control not available in Word for Mac</td>
</tr>
<tr>
<td>13</td>
<td>In the Pool Maintenance table, insert a Combo Box content control in cell B3 (the blank cell to the right of “How frequently do you check your pool’s pH level?”) and format it as follows: a. Use pH level as the title of the control. b. Do not allow the control to be deleted. c. Replace existing choices with Daily, Weekly, Monthly, and Never as the choices in the list. d. Use Click the arrow. as the placeholder text.</td>
<td>In the Pool Maintenance table, insert a Combo Box content control in cell B3 (the blank cell to the right of “How frequently do you check your pool’s pH level?”) and format it as follows: a. Click Options, then insert Daily, Weekly, Monthly, and Never as the choices in the list.</td>
<td>No title of control inserted; instruction to not allow control to be deleted removed; no placeholder text inserted Limited content control options available in Word for Mac</td>
</tr>
<tr>
<td>14</td>
<td>In the Pool Maintenance table, insert a Drop-Down List content control in cell B4 (the blank cell to the right of “How often do you use your pool?”) and format it as follows: a. Use Pool Use as the title of the control. b. Do not allow the control to be deleted. c. Replace existing choices with Rarely and Frequently as the choices in the list. d. Use Click the arrow. as the placeholder text.</td>
<td>In the Pool Maintenance table, insert a Combo Box content control in cell B4 (the blank cell to the right of “How often do you use your pool?”) and format it as follows: a. Click Options, then insert Rarely and Frequently as the choices in the list.</td>
<td>Combo Box rather than Drop-Down List control inserted; no title of control inserted, placeholder text not inserted; instruction to not allow control to be deleted removed Limited content control options available in Word for Mac</td>
</tr>
<tr>
<td>15</td>
<td>In the Pool Maintenance table, insert a Rich Text content control in cell D3 (the blank cell to the right of “What brand of heater is</td>
<td>In the Pool Maintenance table, insert a Text Box content control in cell D3 (the blank cell to the right of “What brand of heater is</td>
<td>Text Box rather than Rich Text control inserted; no title of control specified; default text rather than placeholder text specified</td>
</tr>
<tr>
<td>Step</td>
<td>Windows</td>
<td>MacOS</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>5</td>
<td>In the Plant Maintenance table, press the ALT key and move a gridline to make the “How often do you replace the plants?” row 0.6” high, as indicated by the measurements in the vertical ruler, so that it is the same height as the two rows above it.</td>
<td>In the Plant Maintenance table, move a gridline to make the “How often do you replace the plants?” row 0.6” high, as indicated by the measurements in the vertical ruler, so that it is approximately the same height as the two rows above it.</td>
<td>Alt key not used&lt;br&gt;Alt key not available on Macs</td>
</tr>
<tr>
<td>6</td>
<td>In the Plant Maintenance table, press the ALT key and move a gridline to make Column A 1.3” wide, as indicated in the horizontal ruler. (Hint: Depending on your version of Office, the text “Materials Fee:” and “Estimate (monthly):” in the bottom row may or may not wrap to a second line as shown in the Final Figure.)</td>
<td>In the Plant Maintenance table, move a gridline to make Column A approximately 1.3” wide, as indicated in the horizontal ruler. (Hint: Depending on your version of Office, the text “Materials Fee:” and “Estimate (monthly):” in the bottom row may or may not wrap to a second line as shown in the Final Figure.)</td>
<td>Alt key not used&lt;br&gt;Alt key not available on Macs</td>
</tr>
<tr>
<td>10</td>
<td>In the Client Information table, use the Developer tab to insert a Plain Text content control in cell B2 (the blank cell to the right of “Company name:”) and format it as follows: a. Use Company name as the title of the control.&lt;br&gt;b. Do not allow the control to be deleted.&lt;br&gt;c. Use Enter the company name as the placeholder text.</td>
<td>In the Client Information table, use the Developer tab to insert a Text Box content control in cell B2 (the blank cell to the right of “Company name:”) and format it as follows: a. Use Company name as the title of the control.&lt;br&gt;b. Click the Options button, then enter Enter your name as the default text.</td>
<td>Text Box control rather than Plain Text control inserted; default text rather than placeholder text specified&lt;br&gt;Limited content control options available in Word for Mac</td>
</tr>
<tr>
<td>11</td>
<td>In the Client Information table, insert a Check Box content control next to “Daily” and another one next to “Weekly”. Do</td>
<td>In the Client Information table, insert a Check Box content control to the left of “Daily” and another one to the left of “Weekly”. Be sure to insert a</td>
<td>Removed instruction to not allow controls to be deleted; added instruction to insert a space and place textboxes to the left of text</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
</tbody>
</table>
| 12. | In the Plant Maintenance table, insert a Date Picker content control in cell B2 (the blank cell to the right of “When were your plantings installed?”) and format the content control as follows:  
   a. Use Installation date as the title of the control.  
   b. Do not allow the control to be deleted.  
   c. Use MM yyyy as the date format.  
   d. Use Click the arrow to select a date. as the placeholder text. | In the Plant Maintenance table, insert a Text Box content control in cell B2 (the blank cell to the right of “When were your plantings installed?”) and format the content control as follows:  
   a. Click Options, then Select the Date type.  
   b. Use MMM yy as the date format. | Different functionality for locking content controls available in Word for Mac; added space and position instructions for clarity |
| 13. | In the Plant Maintenance table, insert a Combo Box content control in cell B3 (the blank cell to the right of “How often do you water the plants?”) and format it as follows:  
   a. Use Watering as the title of the control.  
   b. Do not allow the control to be deleted.  
   c. Replace the default choice with Daily, Weekly, Monthly, and Never as the choices in the list.  
   d. Use Click the arrow to select an option. as the placeholder text. | In the Plant Maintenance table, insert a Combo Box content control in cell B3 (the blank cell to the right of “How often do you water the plants?”) and format it as follows:  
   a. Click Options, then insert Daily, Weekly, Monthly, and Never as the choices in the list. | No title of control inserted; instruction to not allow control to be deleted removed; no placeholder text inserted. Limited content control options available in Word for Mac |
| 14. | In the Plant Maintenance table, insert a Drop-Down List content control in cell B4 (the blank cell to the right of “How often do you replace the plants?”) and format it as follows:  
   a. Use Replace as the title of the control.  
   b. Do not allow the control to be deleted.  
   c. Replace the default choice with Rarely and Frequently as the choices in the list.  
   d. Use Click the arrow to select an option. as the placeholder text. | In the Plant Maintenance table, insert a Combo Box content control in cell B4 (the blank cell to the right of “How often do you replace the plants?”) and format it as follows:  
   a. Click Options, then insert Rarely and Frequently as the choices in the list. | Combo Box rather than Drop-Down List control inserted; no title of control inserted, placeholder text not inserted; instruction to not allow control to be deleted removed. Limited content control options available in Word for Mac |
| 15. | In the Plant Maintenance table, insert a Rich Text content control in cell D3 (the blank cell to the right of “Who installed the original plantings?”) and format it as follows:  
   a. Use Original plantings as the title of the control. | In the Plant Maintenance table, insert a Text Box content control in cell D3 (the blank cell to the right of “Who installed the original plantings?”) and format it as follows: | Text Box rather than Rich Text control inserted; no title of control specified; default text rather than placeholder text specified. Limited content control options available in Word for Mac |
<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>To add interest to the document, apply the Lines (Simple) style set, which formats headings using an underline.</td>
<td>Removed.</td>
<td>Line (Simple) style set is not included with Word 2016 for Mac.</td>
</tr>
<tr>
<td>3</td>
<td>Format the list of Board of Directors members and their roles (beginning “Jonathan Colucci” and ending “Member at large”) by setting a left tab stop at 2.5” using the ___ solid line leader option to make the list easier to read.</td>
<td>Format the list of Board of Directors members and their roles (beginning “Jonathan Colucci” and ending “Member at large”) by setting a left tab stop at 2.5” using the ___ solid line leader option to make the list easier to read.</td>
<td></td>
</tr>
<tr>
<td>19/18</td>
<td>On page 1, start a mail merge, and then select Letters as the type of main document. Next, type a new recipient list as follows:   a. Customize the columns by deleting the Company Name, Country or Region, and Work Phone fields.  b. After the E-mail Address field, add a new field using Production as the name.  c. Enter the recipient information shown in bold in Table 3 below.  d. Save the data source using a name of your choice.</td>
<td>On page 1, start a mail merge, and then select Letters as the type of main document. Next, type a new recipient list as follows:   a. Customize the columns by deleting the JobTitle, Company, Country/Region, and WorkPhone fields.  b. After the HomePhone field, add two new fields using EmailAddress and Production as the names.  c. Save the data source using a name of your choice.  d. Enter the recipient information shown in bold in Table 3 below.</td>
<td></td>
</tr>
<tr>
<td>24/23</td>
<td>Complete the mail merge as instructed in the lettered steps below. You will merge to a new document and then copy the contents of the merged file to the bottom of your original document, so that all of your assignment appears in the same file.  a. Finish and merge all records to a new document.  b. In the new document Letters1.docx, which contains the merged form letter, press CTRL+A to select all contents in the document, and then copy the</td>
<td>Complete the mail merge as instructed in the lettered steps below. You will merge to a new document and then copy the contents of the merged file to the bottom of your original document, so that all of your assignment appears in the same file.  a. Finish and merge all records to a new document.  b. In the new document Form Letters1.docx, which contains the merged form letter, press command+A to select all contents in the document, and then copy the</td>
<td></td>
</tr>
</tbody>
</table>
### New Perspectives Word 2016 Modules 8-10: SAM Capstone Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>To complete this project, you need to display the Developer tab. To add this tab to the Word Ribbon, click the File tab to open Backstage View and then click the Options button. In the Word Options dialog box, click Customize Ribbon in the left pane, and then click the Developer check box (refer to Figure 1 on the following page). Click the OK button to close the Word Options dialog box and confirm the Developer tab appears in the Word Ribbon.</td>
<td>To complete this project, you need to display the Developer tab. To add this tab to the Word Ribbon, click the Word menu, and then click Preferences. In the Word Preferences dialog box, under Authoring and Proofing Tools, click View. In the View dialog box, under Ribbon, select the Show developer tab check box so that it is checked.</td>
<td>Removed.</td>
</tr>
<tr>
<td>7</td>
<td>Add cross-references where indicated to Figure 3 and Figure 7. Use only the label and number in the cross-reference.</td>
<td>Replace the placeholder text “[Insert Cross-reference]” with cross-references where indicated to Figure 3 and Figure 7. Use only the label and number in the cross-reference.</td>
<td>Not available in Word 2016 for MacOS. This Style was created for the Start &amp; Support files so it will grade correctly.</td>
</tr>
<tr>
<td>12</td>
<td>Using the Manage Styles and Organizer dialog boxes, copy the style named Company Name from the template file Support_NP_WD16_CS8-10a_WellSpring.dotx, available for download from the SAM website.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 18 | In the Contact Information table, use the Developer tab to insert a Plain Text content control in cell B2 (the blank cell to the right of “Name:”) and format it as follows:  
  
a. Use Full name as the title of the control.  
b. Do not allow the control to be deleted.  
c. Use Enter your full name. as the placeholder text. | Removed. | Not available in Word 2016 for MacOS. |
| 22c/20c | Press the ALT key and move a gridline to make row 4 (the “How do you communicate with employees?” row) 0.5” high, as indicated by the measurements in the vertical ruler. | Press the option key and move a gridline to make row 4 (the “How do you communicate with employees?” row) 0.5” high, as indicated by the measurements in the vertical ruler. |  |
| 22d/20d | Press the ALT key and move a gridline to make Column C 1.55” wide, as indicated in the horizontal ruler. | Press the option key and move a gridline to make Column C 1.55” wide, as indicated in the horizontal ruler. |  |
| 25 | In the Wellness Plans and Goals table, insert a Date Picker content control in cell B4 (the blank cell to the right of “What is your preferred start date?”) and format the content control as follows:  
  
a. Use Start date as the title of the control.  
b. Do not allow the control to be deleted.  
c. Use M/d/yy as the date format.  
d. Use Click the arrow to select a date. as the placeholder text. | Removed. | Not available in Word 2016 for MacOS. |
| 26 | In the Wellness Plans and Goals table, insert a Combo Box content control in cell B5 (the blank cell to the right of “How do you communicate with employees?”) and format it as follows:  
  
a. Use Communication as the title of the control.  
b. Do not allow the control to be deleted.  
c. Replace the default choice with Email, Newsletter, Website, and Staff meetings as the choices in the list.  
d. Use Click the arrow to select an option. as the placeholder text. | Removed. | Not available in Word 2016 for MacOS. |
| 27 | In the Wellness Plans and Goals table, insert a Rich Text content control in cell D3 (the blank cell to the right of “Who should review our proposal?”) and format it as follows:  
  
a. Use Proposal reviewers as the title of the control. | Removed. | Not available in Word 2016 for MacOS. |
b. Do not allow the control to be deleted.
c. Use Enter reviewer names as the placeholder text.

30 On the Info screen in Backstage View, add Avi Patil as the Manager property. Removed. Not available in Word 2016 for MacOS.

31 After the “Approved by:” text, insert a Quick Part using the Manager document property. Removed. Not available in Word 2016 for MacOS.

34/27 Center the contents of the title page vertically, which is the appropriate format for a title page. Center the contents of the title page vertically, which is the appropriate format for a title page. (Click the Format menu, click Document, ensure that Layout is selected at the top of the Document box, and select Center next to Vertical alignment.)

35a/28a Insert the Plain Number 3 page number at the top of each page. Remove the header from the title page by clicking in the Header-Section 1, and selecting the Different First Page check box. Insert a page number at the top of each page and ensure that Alignment is set to Right. Remove the header from the title page by clicking the Show number on first page check box so that it appears as unchecked.

---

Shelley Cashman Excel 2016

Shelly Cashman Excel 2016 Module 7: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>16 and 17</td>
<td>16. The Stillman Sports Center provided sales data in an Access database. In cell B11 of the Stillman worksheet, import data from the Sales table in the Support_SC_EX16_7a_Stillman.accdb Access database file. 17. To make the data in the Stillman worksheet consistent with the data for the other sports centers, format the data and the worksheet as follows: a. Convert the imported Access table to a range.</td>
<td>Go to the Stillman worksheet. To make the data in the Stillman worksheet consistent with the data for the other sports centers, format the data and the worksheet as follows: a. Convert the table in the range B11:G15 to a range. b. Change the width of columns B:G to 12.0 characters. c. Apply the Accounting number format with zero decimal places and $ as the symbol to the range C4:G8. (Hint: Depending on how you perform this step, the number format may be displayed as Custom.)</td>
<td>Performed step 16 in the start file, combined steps 16 and 17 Access not on Mac</td>
</tr>
</tbody>
</table>
### Shelly Cashman Excel 2016 Module 7: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>16. The Bloom store provided sales data in an Access database. In cell B11 of the Bloom worksheet, import data from the Sales table in the Support_SC_EX16_7b_Bloom.accdb Access database file.</td>
<td>Go to the Bloom worksheet. To make the data in the Bloom worksheet consistent with the data for the other events companies, format the data and the worksheet as follows:</td>
<td>Performed step 16 in the start file, combined steps 16 and 17 Access not on Mac</td>
</tr>
<tr>
<td>17</td>
<td>17. To make the data in the Bloom worksheet consistent with the data for the other events companies, format the data and the worksheet as follows:</td>
<td>a. Convert the table in the range B11:G15 to a range.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Convert the imported Access table to a range.</td>
<td>b. Change the width of columns B:G to 12.0 characters.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Change the width of columns B:G to 12.0 characters.</td>
<td>c. Apply the Accounting number format with zero decimal places and $ as the symbol to the range C4:G8.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Apply the Accounting number format with zero decimal places and $ as the symbol to the range C4:G8.</td>
<td>d. Use the Format Painter to copy the formatting of the range B2:G8 to the range B10:G16.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. Use the Format Painter to copy the formatting of the range B2:G8 to the range B10:G16.</td>
<td>d. Use the Format Painter to copy the formatting of the range B2:G8 to the range B10:G16.</td>
<td></td>
</tr>
</tbody>
</table>

### Shelly Cashman Excel 2016 Module 8: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Return to the 2021 North Region Participants worksheet. Select cell A4 and create a PivotChart directly from the data in that table in a new worksheet as described below:</td>
<td>Go to the Size Chart worksheet. Update the worksheet as described below:</td>
<td>Changed PivotChart to clustered column chart PivotCharts not available on Mac</td>
</tr>
<tr>
<td></td>
<td>a. Use Season Size PivotChart as the name of the worksheet.</td>
<td>a. Rename the worksheet using Season Size Chart as the new name of the worksheet.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. If necessary, move the worksheet directly after the 2021 North Region Participants worksheet.</td>
<td>b. Select the range A2:D4 and insert a Clustered Column chart. Switch the rows and columns so that the horizontal axis is grouped by season.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Add the Share Size field to the Legend (Series) area of the PivotChart Fields task pane.</td>
<td>c. Remove the chart title.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. Format the legend so that it is in the Right position.</td>
<td>d. Format the legend so that it is in the Right position.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>e. Move and resize the chart so that the upper left corner is located within cell G2</td>
<td>e. Move and resize the chart so that the upper left corner is located within cell G2</td>
<td></td>
</tr>
</tbody>
</table>
d. Add the Season field to the Axis (Category) area of the PivotChart Fields task pane.
e. Add the Share Type field to the Values area of the PivotChart Fields task pane. Use Shares Sold in North Region as the title of this field.
f. Move and resize the PivotChart so that the upper left corner is located within cell G2 and the lower right corner is located within cell O18.

Shelly Cashman Excel 2016 Module 8: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 8    | Return to the 2020 Customers worksheet. Select cell A4 and create a PivotChart directly from the data in that table in a new worksheet as follows:  
a. Use Project Size PivotChart as the name of the worksheet.  
b. If necessary, move the worksheet directly after the 2020 Customers worksheet.  
c. Add the Crew Size field to the Legend (Series) area of the PivotChart Fields task pane.  
d. Add the Season field to the Axis (Category) area of the PivotChart Fields task pane.  
e. Add the Project Type field to the Values area of the PivotChart Fields task pane. Use Projects by Season as the title of this field.  
f. Move and resize the PivotChart so that the upper-left corner is located within cell G2 and the lower-right corner is located within cell M15. | Go to the Size Chart worksheet. Update the worksheet as described below:  
a. Rename the worksheet using Project Size Chart as the name of the worksheet.  
b. Select the range A2:D4 and insert a Clustered Column chart. Switch the rows and columns so that the horizontal axis is grouped by season.  
c. Remove the chart title.  
d. Format the legend so that it is in the Right position.  
e. Move and resize the chart so that the upper-left corner is located within cell G2 and the lower-right corner is located within cell M15. | Changed PivotChart to clustered column chart PivotCharts not available on Mac |

Shelly Cashman Excel 2016 Module 9: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Mark the workbook as Final to indicate you are finished revising the workbook.</td>
<td>step removed</td>
<td>Step 14 removed Mark as Final not available on Mac</td>
</tr>
</tbody>
</table>

Shelly Cashman Excel 2016 Module 9: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>Windows</td>
<td>MacOS</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 1    | Start by collecting tornado data from another Excel workbook, which includes the Enhanced Fujita scale, a way to rate tornadoes according to the amount of damage they cause. Use the Get & Transform tools to create a query and load data from this workbook into a new table as follows:  
  b. Load the data from the Tornadoes worksheet to a table in a new worksheet in the SC_EX16_10a_FirstLastName_2.xlsx workbook, using Tornadoes as the name of the new worksheet.  
  c. Because all of the data is for tornadoes in Nebraska, use the Query Editor to remove the State column, and then load the transformed data into the worksheet. | Start by collecting tornado data from another file, which includes the Enhanced Fujita scale, a way to rate tornadoes according to the amount of damage they cause.  
  a. Create a new query that imports data from the Support_SC_EX16_Mac_10a_2013-2015.txt file in a new worksheet in the SC_EX16_Mac_10a_FirstLastName_2.xlsx workbook.  
  b. Start loading the data at row 1, mark the file as having headers, and separate the columns using tab delimiters.  
  c. Because all of the data is for tornadoes in Nebraska, skip the State column, and then load the transformed data into the new worksheet using Tornadoes as the name of the new worksheet.  
  d. Format the imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.) | Imported data from text instead of using Power Query  
Power BI not on Mac                                                                 |
| 2    | The client wants to know the population of the twenty most populous counties in Nebraska. To provide this information, create another query and load data from another Excel workbook into a new table as follows:  
  a. Create a new query that imports data from the Support_SC_EX16_10a_Population.xlsx file, available for download from the SAM website.  
  b. Load the data from the Population by County worksheet to a table in a new worksheet in the SC_EX16_10a_FirstLastName_2.xlsx workbook, using Top 20 Population as the name of the new worksheet.  
  c. Edit the table to display the data the client requested and make it more useful as follows:  
    o Use the Query Editor to remove the top 3 rows, which contain a heading or blank cells. | The client wants to know the population of the twenty most populous counties in Nebraska. To provide this information, create another query as follows:  
  a. Create a new query that imports data from the Support_SC_EX16_Mac_10a_Population.txt file in a new worksheet in the SC_EX16_Mac_10a_FirstLastName_2.xlsx workbook.  
  b. Start loading the data at row 4, mark the file as having headers, and separate the columns using tab delimiters.  
  c. Skip column 5 and then load the transformed data into the new worksheet using Top 20 Population as the name of the new worksheet.  
  d. Format the imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.)  
  e. To make the data the client requested more useful, sort the data in descending order by Population, and then delete all | Imported data from text instead of using Power Query  
Power BI not on Mac                                                                 |
| 3 | Add the two queries you created to the data model so you can use them with Power Pivot as follows:  
   a. Add the Population by County query to the data model.  
   b. Add the Tornadoes query on the Tornadoes worksheet to the data model. (Hint: Do not close the Power Pivot for Excel window after performing this substep.)  
   c. Use the Power Pivot for Excel window to create a PivotTable in a new worksheet.  
   d. Use Tornado PivotTable as the name of the new worksheet.  
   The client wants to know which of the twenty most populated counties experienced tornadoes in 2013–2015 along with the population of each county. Build the new PivotTable to display the tornado and population data at the same time as follows:  
   e. Use the following fields from the Population_by_County table in the PivotTable areas:  
      o County field: Rows box  
      o Population field: Values box  
   f. Use the following field from the Tornadoes table in the PivotTable areas:  
      o Fujita field: Values box  
   g. Create a relationship using the following tables and columns:  
      o Table: Tornadoes  
      o Column (Foreign): County  
      o Related Table: Population_by_County  
      o Related Column (Primary): County  
   h. Use County as the column heading in cell B3, use Population as the column heading in cell C3, and use Tornadoes as the column heading in cell D3. (Hint: The “(blank)” entry is for tornadoes that occurred in counties not among the 20 most populated counties.) | The client wants to know which of the twenty most populated counties experienced tornadoes in 2013–2015 along with the population of each county. The data has been combined to create a PivotTable to find common features between the two data sets. Build the new PivotTable to display the tornado and population data at the same time as follows:  
   a. Rename the Sheet2 worksheet using Tornado PivotTable as the name of the worksheet.  
   b. Use the following fields in the PivotTable areas:  
      o County (P) field: Rows box  
      o Population field: Values box  
      o Fujita field: Values box  
   c. Summarize the Count of Population field using the Sum function.  
   d. Use County as the column heading in cell B3, use Population Count as the column heading in cell C3, and use Tornadoes as the column heading in cell D3. (Hint: The “(blank)” entry is for tornadoes that occurred in counties not among the 20 most populated counties.) | Use table for PivotTable instead of Data Model Loading to Data Model not available on Mac |
| 4 | The client wants to know how concentrated the population is in each of the 20 most populous counties. Create another PivotTable that shows the concentration of population. | The client wants to know how concentrated the population is in each of the 20 most populous counties. Create another PivotTable that shows the concentration of population. | Use table for PivotTable instead of Data Model Loading to Data Model not available on Mac |
### Chapter 5

To add a column showing the population per square mile, create a measure as follows:

1. Use Population per Sq Mi as the name of the new measure.
2. Use ([Sum of Population])/([Sum of Sq Mi]) as the formula.
3. Choose Number as the category and Whole Number as the format.

To provide another visual representation of the tornado data for the top 20 most populated Nebraska counties, create a Power View report as follows:

1. Insert a Power View report on a new worksheet, using Power View as the name of the new worksheet.
2. Select the Fujita field in the Tornadoes table.
3. Select the County and Population fields (in that order) in the Population_by_County table. (Hint: If a message appears indicating you may need relationships between tables, close the message. You already created the relationships.)
4. Resize the table to fill the left pane of the Power View area.
5. Add the Fujita field in the Tornadoes table to the Filters pane.
6. Filter the data to display populations for counties that experienced tornadoes with an EF-1 rating.
7. Switch the visualization of the data to a Clustered Bar chart.
8. Use County Population and Tornado Rating as the chart title.

### Chapter 6

To add a column showing the population per square mile, create a calculated column as follows:

1. Divide the Population column by the Sq Mi column as the formula.
2. Use Population per Sq Mi as the custom name of the calculated column.
3. Format the field using the Number number format with 0 decimal places.

To provide a visual representation of the tornado data for the top 20 most populated Nebraska counties, create a chart as follows:

1. In the County Population Fujita worksheet, add the Fujita and Population fields in order to the filters area of the PivotTable.
2. Filter the PivotTable to only include counties that have a Fujita rating of EF-1 and contain population data.
3. Insert a Clustered Bar chart based on the data in the PivotTable. Move the clustered bar chart to a new worksheet, using CPF Chart as the name of the worksheet.
4. Format the chart using the Style 7 chart style.
5. Add a legend to the chart in the Right position. Switch the column and row data so that the legend shows the county names.
6. Use EF-1 as the horizontal axis label.
7. Add a primary horizontal axis title using Population Count as the title.
8. Use County Population and Tornado Rating as the chart title.
| 7 | Switch to the Top 20 Population worksheet. To develop a map showing tornado data for the 20 most populated counties in Nebraska, create a 3D map as follows:  
   a. Open the 3D Maps window, and in Scene 1, use the State field in the Population_by_County table as a Location to focus on the state of Nebraska.  
   b. Display state name labels on the map.  
   c. Add the County field in the Population_by_County table as a second Location to indicate the 20 most populous counties in Nebraska.  
   d. Add the Fujita field in the Tornadoes table as the Height to show where the most tornadoes occurred.  
   e. Close the field list, remove the legend, and zoom in six times to display the Nebraska city names on the map, and then tilt the map up four times.  
   f. Create a text box using Tornadoes in the Top 20 Nebraska Counties as the text in the title field.  
   g. Capture the screen showing the 3D map, and then close the 3D Maps window.  
   h. Paste the map in cell A1 of the Home Page worksheet in the SC_EX16_10a_FirstLastName_2.xlsx workbook. | Switch to the Top 20 Population worksheet. To show tornado data for the 20 most populated counties in Nebraska, display a 3D map as follows:  
   a. Insert the map image Support_SC_EX16_10a_Map.png in cell A1 of the Home Page worksheet in the SC_EX16_Mac_10a_FirstLastName_2.xlsx workbook.  
   b. Resize and reposition the image so that the upper-left corner is within cell A1 and the lower-right corner is within cell L24.  
   c. Insert a Horizontal Textbox using Tornadoes in the Top 20 Nebraska Counties as the text.  
   d. Format the textbox using the Transparent – Black, Dark 1 shape style, and change the font size to 28 pts.  
   e. Resize and reposition the textbox so that the upper-left corner is within cell C7 and the lower-right corner is within cell L24. | Use pre-created map instead of making 3D map  
Power BI not on Mac |
| 9 | Your supervisor, Karen Chao, wants to include a note on two worksheets that the Tornado Center created this workbook. Create and record a macro to automate this task as follows:  
   a. Enable all macros in the workbook, and make sure the Use Relative References option is selected in the Developer tab.  
   b. Select cell M7.  
   c. Create a macro to be stored in this workbook using Created_by as the name of the macro.  
   d. Use CTRL+m as the shortcut key.  
   e. Begin recording the macro, and enter the following text in cell M7:  
      This workbook was created by the Tornado Center at the University of Nebraska.  
   f. Apply wrap text formatting to cell M7.  
   g. Stop recording the macro. | Your supervisor, Karen Chao, wants to include a note on two worksheets that the Tornado Center created this workbook. Create and record a macro to automate this task as follows:  
   a. Enable all macros in the workbook, and make sure the Use Relative References option is selected in the Developer tab.  
   b. Select cell M7.  
   c. Create a macro to be stored in this workbook using Created_by as the name of the macro.  
   d. Use CTRL+m as the shortcut key.  
   e. Begin recording the macro, and enter the following text in cell M7:  
      This workbook was created by the Tornado Center at the University of Nebraska.  
   f. Apply wrap text formatting to cell M7.  
   g. Stop recording the macro. | Change macro shortcut  
Default macro shortcuts different on Mac |
### Shelly Cashman Excel 2016 Module 10: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| **1** | Start by collecting population data from another Excel workbook, which lists the Minnesota population. Use the Get & Transform tools to create a query and load data from this workbook into a new table as follows:  
  a. Create a new query that imports data from the Support_SC_EX16_10b_Households.xlsx workbook.  
  b. Load the data from the Minnesota Households worksheet to a table in a new worksheet in the SC_EX16_10b_FirstLastName_2.xlsm workbook, using Households as the name of the new worksheet.  
  c. Because all of the data is for the population in Minnesota, use the Query Editor to remove the State column and Column 7, which contains null data, and then load the transformed data into the worksheet.  
  d. For the Persons per Household data, decrease the decimal places to two places. | Start by collecting population data from another file, which lists the Minnesota population.  
  a. Create a new query that imports data from the Support_SC_EX16_10b_Households.txt file in a new worksheet in the SC_EX16_Mac_10a_FirstLastName_2.xlsx workbook.  
  b. Start loading the data at row 1, mark the file as having headers, and separate the columns using tab delimiters.  
  c. Because all of the data is for Minnesota, skip the State column, and then load the transformed data into the new worksheet using Households as the name of the new worksheet.  
  d. Format the imported data as a table with headers using the Table Style Dark 9 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.)  
  e. For the Persons per Household data, set the decimal places to two places. | Imported data from text instead of using Power Query  
  Power BI not on Mac |
| **2** | The client wants to know the the twenty most populous counties in Minnesota. To provide this information, create another query and load data from another Excel workbook into a new table as follows:  
  b. Load the data from the Minnesota Population worksheet to a table in a new worksheet in the SC_EX16_10b_FirstLastName_2.xlsm workbook, using Top 20 Counties as the name of the new worksheet.  
  c. Edit the table to display the data the client requested and make it more useful as follows:  
    o Use the Query Editor to remove the top 2 rows, which contain a heading or blank cells.  
    o Remove column 6, which includes a record count.  
    o Use the first row as headers.  
    o Sort the data in descending order by Population. | The client wants to know the the twenty most populous counties in Minnesota. To provide this information, create another query as follows:  
  a. Create a new query that imports data from the Support_SC_EX16_10b_MN_Population.txt file in a new worksheet in the SC_EX16_Mac_10b_FirstLastName_2.xlsx workbook.  
  b. Start loading the data at row 3, mark the file as having headers, and separate the columns using tab delimiters.  
  c. Skip column 6, which includes a record count, and then load the transformed data into the new worksheet using Top 20 Counties as the name of the new worksheet.  
  d. Format the imported data as a table with headers using the Table Style Dark 9 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.)  
  e. To make the data the client requested more useful, sort the data in descending order by Population, and then delete all rows of data except the header row and the top 20 rows of data. | Imported data from text instead of using Power Query  
  Power BI not on Mac |
3 Add the two queries you created to the data model so you can use them with Power Pivot as follows:
   a. Add the Minnesota Population query to the data model.
   b. Add the Minnesota Households query to the data model. (Hint: Do not close the Power Pivot for Excel window after performing this substep.)
   c. Use the Power Pivot for Excel window to create a PivotTable in a new worksheet, and use Household PivotTable as the new worksheet's name.
   The client wants to know the number of people per household in the twenty most populated counties along with each's population. Build a new PivotTable as follows:
   d. Use the following fields from the Minnesota_Population table in the PivotTable areas:
      o County Name field: Rows box
      o Population field: Values box
   e. Use the following field from the Minnesota_Households table in the PivotTable area:
      o Persons Per Household (PPH) field: Values box (Add this below the Population field.)
   f. Create a relationship using the following tables and columns:
      o Table: Minnesota_Households
      o Column (Foreign): County
      o Related Table: Minnesota_Population
      o Related Column (Primary): County Name
   g. From the PivotTable Fields pane, use Population as the column heading in cell C3, and use Persons Per Household as the column heading in cell D3. (Hint: The "(blank)" entry is for data for counties other than those with the top 20 population.)
   h. Format the Persons Per Household data using the Number format with 2 decimal places and no thousands separator.

4 The client wants to know how concentrated the population is in each of the 20 most populous counties. Create another PivotTable that shows the population per square mile in these counties as follows:
<table>
<thead>
<tr>
<th>Exercise</th>
<th>Instructions</th>
</tr>
</thead>
</table>
| **1** | a. Use the Power Pivot for Excel window to create a second PivotTable in a new worksheet. (Hint: If necessary, use the Manage button in the Data Model group on the Power Pivot tab to open the Power Pivot for Excel window.)  
b. Use Population PivotTable as the name of the new worksheet. Close the Power Pivot for Excel window.  
c. Build the new PivotTable to use the following fields from the Minnesota_Population table in the PivotTable areas:  
  - County Name field: Rows box  
  - Population field: Values box  
  - Sq Mi field: Values box |
| **4** | a. Using the table in the Top 20 Counties worksheet, create a second PivotTable in a new worksheet, using Population PivotTable as the name of the new worksheet.  
b. Build the new PivotTable using the following fields in the PivotTable areas:  
  - County Name field: Rows box  
  - Population field: Values box  
  - Sq Mi field: Values box |
| **5** | To add a column showing the population per square mile, create a measure as follows:  
  a. Use Population per Sq Mi as the name of the new measure.  
  b. Use [Sum of Population]/[Sum of Sq Mi] as the formula.  
  c. Choose Number as the category and Whole Number as the format. |
| **6** | To provide another visual representation of the data for the top 20 most populated Minnesota counties, create a Power View report as follows:  
  a. Insert a Power View report on a new worksheet, using Power View as the name of the new worksheet.  
  b. Select the County Name and Population fields (in that order) in the Minnesota_Population table. (Hint: If a message appears indicating you may need relationships between tables, close the message, since you have already created the relationships.)  
  c. Extend the table to the right and to the bottom to fill the left pane of the Power View area.  
  d. Add the County Name field in the Minnesota_Population table to the Filters pane.  
  e. Filter the data to display population for the counties Anoka, Dakota, Hennepin, Ramsey, and Washington.  
  f. Switch the visualization of the data to a Clustered Bar chart.  
  g. Use Population by County as the title. |
| **7** | To provide a visual representation of the data for the top 20 most populated Minnesota counties, create a chart as follows:  
  a. In the County Population worksheet, add the County Name field to the Rows area and the Population field to the Values area of the PivotTable. Summarize the Count of Population field using the Sum function.  
  b. Filter the data to only display population for the counties Anoka, Dakota, Hennepin, Ramsey, and Washington.  
  c. Insert a Clustered Bar chart based on the data in the PivotTable. Move the clustered bar chart to a new worksheet, using CP Chart as the name of the worksheet.  
  d. Format the chart using the Style 3 chart style.  
  e. Add a legend to the chart in the Right position. Switch the column and row data so that the legend shows the county names.  
  f. Use the range B4:B8 as the horizontal axis labels.  
  g. Add a primary horizontal axis title using Population Count as the title.  
  h. Use Population by County as the chart title. |
<table>
<thead>
<tr>
<th>Page</th>
<th>Text</th>
</tr>
</thead>
</table>
| 7 | Switch to the Top 20 Counties worksheet. To develop a map showing the household data for the 20 most populated counties in Minnesota, create a 3D map as follows:  
a. Open the 3D Maps window, and in Scene 1, use the State field in the Minnesota_Population table as a Location to focus on the state of Minnesota.  
b. Display state name labels on the map.  
c. Add the County Name field in the Minnesota_Population table as a second Location to indicate the 20 most populous counties in Minnesota.  
d. Add the Households field in the Minnesota_Households table as the Height to show where the most people live.  
e. Close the field list, remove the legend, and zoom in six times to display the Minnesota city names on the map, and then tilt the map up six times.  
f. Create a text box using Households in the Top 20 Minnesota Counties as the text in the title field.  
g. Capture the screen showing the 3D map, and then close the 3D Maps window.  
h. Paste the map in cell A3 of the Home Page worksheet in the SC_EX16_10b_FirstLastName_2.xlsx workbook. |
| 8 | Switch to the Top 20 Counties worksheet. To develop a map showing the household data for the 20 most populated counties in Minnesota, create a 3D map as follows:  
a. Insert the map image Support_SC_EX16_10a_Map.png in cell A3 of the Home Page worksheet in the SC_EX16_Mac_10a_FirstLastName_2.xlsx workbook.  
b. Resize and reposition the image so that the upper-left corner is within cell A3 and the lower-right corner is within cell J30.  
c. Insert a Horizontal Textbox using Tornadoes in the Top 20 Nebraska Counties as the text.  
d. Format the textbox using the Transparent – Orange, Accent 2 shape style, and change the font size to 28 pts.  
e. Resize and reposition the textbox so that the upper-left corner is within cell E9 and the lower-right corner is within cell J14. |
| 9 | Tim wants to include a note on two worksheets that you created in this workbook. While still on the Home Page worksheet, create and record a macro to automate this task as follows:  
a. Enable all macros in the workbook, and make sure the Use Relative References option is selected in the Developer tab.  
b. Select cell A34.  
c. Create a macro to be stored in this workbook using Created_by as the name of the macro.  
d. Use CTRL+m as the shortcut key.  
e. Begin recording the macro, and enter the following text in cell A34: This workbook was created by Hennepin Consultants.  
f. Apply wrap text formatting to cell A34.  
g. Stop recording the macro. |

© 2018 Cengage Learning / Revised January 2018
<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 1    | Fernanda Laine works for her father Ricardo at Ricky Laine's Masonry, doing whatever needs to be done around the office. She is completing an Excel workbook that was left incomplete by a former employee. Switch to the Repair Quotes worksheet. Merge the changes made in the Support_SC_EX16_11a_AaronE.xlsm workbook into SC_EX16_11a_FirstLastName_2.xlsm. Using the Select Changes to Accept or Reject dialog box, review all changes in the range A1:D13 of the Repair Quotes worksheet as follows:

a. Accept the changes made in cells B5, B6, C8, and A13.

b. Reject the changes made in cells C7, D9, and B10.

Turn off workbook sharing. | Fernanda Laine works for her father Ricardo at Ricky Laine's Masonry, doing whatever needs to be done around the office. She is completing a merged Excel workbook that was left incomplete by a former employee. Switch to the Repair Quotes worksheet. Using the Select Changes to Accept or Reject dialog box, review all changes in the range A1:D13 of the Repair Quotes worksheet as follows:

a. Accept the changes made in cells B5, B6, C8, and A13.

b. Reject the changes made in cells C7, D9, and B10.

Turn off workbook sharing. | Support file pre-merged Compare and merge not available on Mac |
| 16   | With the Customer Entry worksheet active, turn on Design Mode. Add a Command Button (ActiveX Control) to the worksheet, and resize and reposition the button so that it is completely within cell D2. Update the button as described below:

a. Use the text Clear Customer Info to replace the placeholder text.

b. View the code associated with this button. Enter the following VBA code between the “Private Sub CommandButton3_Click()” and “End Sub” lines:

Range(“B4:B8”).ClearContents
Range(“D4:D7”).ClearContents
Range(“J26:K26”).ClearContents

(Hint: There are no spaces before or after the parentheses in the code.)

c. Confirm that your VBA code is correct by switching back to the Customer Entry worksheet, turning off Design Mode, and clicking the button labeled “Clear Customer Info”. The ranges B4:B8 and D4:D7 should be blank and none of the request type, work request, or job type form controls should be checked. | With the Customer Entry worksheet active, add a Command Button (Form Control) to the worksheet, and resize and reposition the button so that it is completely within cell D2. Update the button as described below:

a. Create a new macro and enter the following VBA code between the “Sub Button22_Click()” and “End Sub” lines:

Range(“B4:B8”).ClearContents
Range(“D4:D7”).ClearContents
Range(“J26:K26”).ClearContents

(Hint: There are no spaces before or after the parentheses in the code.)

b. Use the text Clear Customer Info to replace the placeholder text.

c. Confirm that your VBA code is correct by switching back to the Customer Entry worksheet and clicking the button labeled “Clear Customer Info”. The ranges B4:B8 and D4:D7 should be blank and none of the request type, work request, or job type form controls should be checked. | Used Form Control instead of ActiveX Control ActiveX not available on Mac |
<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Brittany Keele works part-time at Heirloom Woodworking, a custom woodworking shop in Irving, Texas. She is completing an Excel workbook that one of the carpenters started but has not had time to finish. Switch to the Repair Quotes worksheet. Merge the changes made in the Support_SC_EX16_11b_DerekLee.xlsm workbook into SC_EX16_11b_FirstLastName_2.xlsm. Using the Select Changes to Accept or Reject dialog box, review all changes in the range A1:D11 of the Repair Quotes worksheet as follows: a. Accept the changes made in cells B7, C7, B9, and D5. b. Reject all the remaining changes. Turn off workbook sharing.</td>
<td>Brittany Keele works part-time at Heirloom Woodworking, a custom woodworking shop in Irving, Texas. She is completing an Excel workbook that one of the carpenters started but has not had time to finish. Switch to the Repair Quotes worksheet. Using the Select Changes to Accept or Reject dialog box, review all changes in the range A1:D11 of the Repair Quotes worksheet as follows: a. Accept the changes made in cells B7, C7, B9, and D5. b. Reject all the remaining changes. Turn off workbook sharing.</td>
<td>Support file pre-merged Compare and merge not available on Mac</td>
</tr>
<tr>
<td>16</td>
<td>With the Customer Entry worksheet active, turn on Design Mode. Add a Command Button (ActiveX Control) to the worksheet, and resize and reposition the button so that it completely covers the darker gold area within cell D2. Update the button as follows: a. Use the text Clear Customer Data to replace the placeholder text. b. Use the Properties window to change the font to Calibri. c. View the code associated with this button. Enter the following VBA code between the “Private Sub CommandButton3_Click()” and “End Sub” lines: Range(”B4:B8”).ClearContents Range(”D4:D7”).ClearContents Range(”J26:K26”).ClearContents Range(”L25:S25”).ClearContents (Hint: There are no spaces before or after the parentheses in the code.) d. Confirm that your VBA code is correct by switching back to the Customer Entry worksheet, turning off Design Mode, and clicking the button labeled “Clear Customer Data”. The ranges B4:B8 and D4:D7 should be blank and none of the request type, work request, or job type form controls should be checked.</td>
<td>With the Customer Entry worksheet active, add a Command Button (Form Control) to the worksheet, and resize and reposition the button so that it completely covers the darker gold area within cell D2. Update the button as follows: a. View the code associated with this button. Enter the following VBA code between the “Sub Button21_Click()” and “End Sub” lines: Range(”B4:B8”).ClearContents Range(”D4:D7”).ClearContents Range(”J26:K26”).ClearContents Range(”L25:S25”).ClearContents (Hint: There are no spaces before or after the parentheses in the code.) b. Use the text Clear Customer Data to replace the placeholder text. c. Use the Properties window to change the font to Calibri. d. Confirm that your VBA code is correct by switching back to the Customer Entry worksheet, turning off Design Mode, and clicking the button labeled “Clear Customer Data”. The ranges B4:B8 and D4:D7 should be blank and none of the request type, work request, or job type form controls should be checked.</td>
<td>Used Form Control instead of ActiveX Control ActiveX not available on Mac</td>
</tr>
</tbody>
</table>
Shelly Cashman Excel 2016 Modules 9-11: SAM Capstone Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td><strong>Create a PivotTable and PivotChart in the 2020 Sales by Project worksheet to analyze project sales as follows:</strong>&lt;br&gt;a. Insert a PivotChart &amp; PivotTable in cell G3 based on the Projects table in the range A3:F21.&lt;br&gt;b. Move the PivotChart so that the upper-left corner is located within cell A23 and the lower-right corner is located within cell F37.&lt;br&gt;c. Add the State field to the Columns area of the PivotTable Fields task pane.&lt;br&gt;d. Add the Project Type field to the Rows area of the PivotTable Fields task pane.&lt;br&gt;e. Add the Sales field to the Values area of the PivotTable Fields task pane. (Hint: The field name will be updated to Sum of Sales.)&lt;br&gt;In the 2020 Sales by Project worksheet, create and modify a PivotTable to analyze project sales as follows:&lt;br&gt;a. Insert a PivotTable in cell G3 based on the Projects table in the range A3:F21.&lt;br&gt;b. Add the State field to the Columns area of the PivotTable Fields task pane.&lt;br&gt;c. Add the Project Type field to the Rows area of the PivotTable Fields task pane.&lt;br&gt;d. Add the Sales field to the Values area of the PivotTable Fields task pane. (Hint: The field name will be updated to Sum of Sales.)&lt;br&gt;e. Apply the Currency number format, with 0 decimal places and $ as the symbol, to the Sum of Sales field in the PivotTable.&lt;br&gt;f. Apply the Pivot Style Medium 14 style to the PivotTable to coordinate with the Projects table on the same worksheet. (Hint: Depending on your version of Office, the PivotTable style may appear as Light Green, Pivot Style Medium 14.)&lt;br&gt;Created PivotTable instead of PivotTable &amp; PivotChart PivotCharts not available on Mac</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td><strong>Modify and format the PivotTable and PivotChart to provide more meaningful information as follows:</strong>&lt;br&gt;a. Refresh the data in the PivotTable and PivotChart to be sure they display accurate data.&lt;br&gt;b. Apply the Currency number format, with 0 decimal places and $ as the symbol, to the Sum of Sales field in the PivotTable.&lt;br&gt;c. Apply the Pivot Style Medium 14 style to the PivotTable to coordinate with the Projects table on the same worksheet. (Hint: Depending on your version of Office, the PivotTable style may appear as Light Green, Pivot Style Medium 14.)&lt;br&gt;d. Add the title Projects by State to the PivotChart in the Above Chart position.&lt;br&gt;e. Add a Primary Vertical Axis title to the chart. Use Project Sales as the Primary Vertical Axis title.&lt;br&gt;f. Change the fill color of the Chart Area to Green, Accent 6, Lighter 80% (10th column, 2nd row in the Theme Colors palette).&lt;br&gt;Create and modify a chart to accompany the PivotTable as follows:&lt;br&gt;a. Insert a Clustered Column chart based on the data in the PivotTable, using the option with the state names in the legend.&lt;br&gt;b. Use the range G5:G9 as the horizontal axis label.&lt;br&gt;c. Move the chart so that the upper-left corner is located within cell A23 and the lower-right corner is located within cell F37.&lt;br&gt;d. Add the title Projects by State to the chart in the Above Chart position.&lt;br&gt;e. Add a Primary Vertical Axis title to the chart. Use Project Sales as the Primary Vertical Axis title.&lt;br&gt;f. Change the fill color of the Chart Area to Green, Accent 6, Lighter 80% (10th column, 2nd row in the Theme Colors palette).&lt;br&gt;Changed PivotChart to clustered column chart PivotCharts not available on Mac</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 26   | **To help determine whether the company will expand into Florida,**

To help determine whether the company will expand into Florida, Blake has asked

Imported data from text instead of using Power Query |

© 2018 Cengage Learning / Revised January 2018
Blake has asked you to gather data on Florida demographics for the last year. Collect Florida population data from another Excel workbook, and then use the Get & Transform tools to create a query and load data from this workbook into a new table as follows:

| a. Create a new query that imports data from the Support_SC_EX16_CS8-11a_FLPop.xlsx workbook. |
| b. Load the data from the 2019 FL Population worksheet to a table in a new worksheet in the SC_EX16_CS8-11a_FirstLastName_2.xlsx workbook, using Florida Population as the name of the new worksheet. |
| c. Use the Query Editor to remove Column2, which is blank, and the State column, considering that all of the data is for the population in Florida. |
| d. Use the Query Editor to remove the top row and the bottom 7 rows. Use the first row as headers, and then load the transformed data into the worksheet. |

You to gather data on Florida demographics for the last year. Load Florida population data from a CSV file into a new table as follows:

| a. Import data from text using the Support_SC_EX16_Mac_M8-11a_FLPop.csv file to a new worksheet in the SC_EX16_Mac_M8-11a_FirstLastName_2.xlsx workbook. |
| b. Start loading the data at row 2, mark the file as having headers, and separate the columns using comma delimiters. |
| c. Edit the data to remove the second column, which is blank, and the State column, as all of the data is for the population in Florida. |
| d. Clear the extra data in rows 416 to 418. |
| e. Format the remaining imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.) |

Blake also wants to determine the Florida locations for the most severe thunderstorms in the last two years. To provide this information, create another query and load data from another Excel workbook into a new table as follows:

| a. Create a new query that imports data from the Support_SC_EX16_CS8-11a_Weather.xlsx file, available for download from the SAM website. |
| b. Load the data from the Severe Weather Data worksheet to a table in a new worksheet in the SC_EX16_CS8-11a_FirstLastName_2.xlsx workbook, using Florida Thunderstorms as the name of the new worksheet. |
| c. Use the Query Editor to remove Column2, which is blank, and the State column, considering that all of the data is for Florida. |
| d. Use the Query Editor to remove the top row, the bottom 2 rows, and the fifth column, which includes the time, which Blake doesn't need. |
| e. Use the first row as headers. |
| f. Filter the data to display only “Thunderstorm” in the Type column. |
| g. Sort the data in descending order by Magnitude. |

| Imported data from text instead of using Power Query Power BI not on Mac | Blake also wants to determine the Florida locations for the most severe thunderstorms in the last two years. To provide this information, load data from another Excel file into a new table as follows: |
| a. Import data from text using the Support_SC_EX16_Mac_M8-11a_Weather.csv file. |
| b. Start loading the data at row 3, mark the file as having headers, and separate the columns using comma delimiters. |
| c. Edit the data to remove the Time column, and load the data into a new worksheet, using Florida Thunderstorms as the name of the new worksheet. |
| d. Format the remaining imported data as a table with headers using the Table Style Medium 7 table style. (Hint: If an alert comes up, press “Yes” to convert the range to a table.) |
| e. Filter the data by the Type column to display only thunderstorms, and then sort the data in descending order by Magnitude. |
| f. Delete all rows below the header and top 20 rows of filtered data. |
| g. Use AutoFit to change the width of columns B and C. |
Keep the top 20 rows of the data.
Load the transformed data into the worksheet.

| 28 | Add the two queries you created to the data model so you can use them with Power Pivot as follows:
|    | a. Add the 2019 FL Population query to the data model.
|    | b. Add the Severe Weather Data query to the data model. (Hint: Do not close the Power Pivot for Excel window after performing this substep.)
|    | c. Use the Power Pivot for Excel window to create a PivotTable in a new worksheet.
|    | d. Use Thunderstorm PivotTable as the name of the new worksheet.
|    | e. Blake wants to know the number of people in the locations that experienced the most severe thunderstorms in Florida last year. Build the new PivotTable to display the severe weather and population data at the same time as follows:
|    | f. Use the following fields from the _2019_FL_Population table in the PivotTable areas:
|    | o County field: Rows box
|    | o Population field: Values box
|    | g. Use the following field from the Severe_Weather_Data table in the PivotTable areas:
|    | o Magnitude field: Values box
|    | h. Create a relationship using the following tables and columns:
|    | o Table: Severe_Weather_Data
|    | o Column (Foreign): Location
|    | o Related Table: _2019_FL_Population
|    | o Related Column (Primary): Municipality
|    | i. Format the Population data using the Number format with 0 decimal places and a thousands separator.
|    | j. Summarize the Magnitude data using the Average calculation, and format the Magnitude data using the Number format with 1 decimal place and no thousands separator.
|    | k. Use Location as the column heading in cell B3, use Population Count as the column heading in cell C3, and use Storm Magnitude as the column heading in cell D3.

The client wants to know which of the twenty most populated counties experienced tornadoes in 2013-2015 along with the population of each county. The data has been combined to create a PivotTable to find common features between the two data sets. Build the new PivotTable to display the tornado and population data at the same time as follows:

|    | a. Rename the Sheet4 worksheet using Thunderstorm PivotTable as the name of the worksheet.
|    | b. Use the following fields in order in the PivotTable areas:
|    | o County (P) field: Rows box
|    | o Population field: Values box
|    | o Magnitude field: Values box
|    | c. Summarize the Count of Population field using the Sum function, and format the Population data using the Number format with 0 decimal places and a thousands separator.
|    | d. Summarize the Count of Magnitude data using the Average calculation, and format the Magnitude data using the Number format with 1 decimal place and no thousands separator.
|    | e. Use Location as the column heading in cell B3, use Population Count as the column heading in cell C3, and use Storm Magnitude as the column heading in cell D3.

Use table for PivotTable instead of Data Model
Loading to Data Model not available on Mac
To provide another visual representation of the data for the population of the locations for the five most severe thunderstorms, create a Power View report as follows:

a. Insert a Power View report on a new worksheet, using Power View as the name of the new worksheet. Move the newly created worksheet so that it's the fourteenth worksheet in the workbook.

b. Select the County and Population fields (in that order) in the _2019_FL_Population table. (Hint: If a message appears indicating you may need relationships between tables, close the message. You already created the relationships.)

c. Resize the table to fill the left pane of the Power View area.

d. Add the County field in the _2019_FL_Population table to the Filters pane.

e. Filter the data to display population for the counties Bradford, Collier, Franklin, Jackson, and Lee.

f. Switch the visualization of the data to a Clustered Bar chart.

g. Use Most Severe T-storms in Florida 2019 as the chart title.

To provide a visual representation of the data for the population of the locations for the five most severe thunderstorms, create a chart as follows:

a. In the Severe Storms worksheet, add the County field in order to the filters area of the PivotTable beginning in cell A3.

b. Filter the data to display population for the counties Bradford, Collier, Franklin, Jackson, and Lee.

c. Insert a Clustered Bar chart based on the data in the PivotTable, using the option with the county names in the vertical axis. Move the clustered bar chart to a new worksheet, using Florida Severe Storms as the name of the worksheet.

d. Format the chart using the Style 7 chart style.

e. Use the range A4:A8 as the horizontal axis label.

f. Add a primary horizontal axis title using Population Count as the title.

g. Use Most Severe T-storms in Florida 2019 as the chart title.

---

Shelley Cashman PowerPoint 2016

Shelly Cashman PowerPoint 2016 Module 10: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>4a</td>
<td>Embed the chart from the file Support_SC_PPT16_10a_Size.xlsx available for download from the SAM website so that any edits you make only change the version you inserted in the presentation. (Hint: To Embed, use the Insert Object dialog box and select Create from file.)</td>
<td>Embed the chart from the file Support_SC_PPT16_Mac_10a_Size.xlsx available for download from the SAM website. (Hint: To Embed, open the Support_SC_PPT16_Mac_10a_Size.xlsx file, copy the chart, and paste/embed the file on Slide 3 keeping the Source formatting. A Grant File Access dialog box may open. If this occurs, click Select..., and then click Grant Access.)</td>
<td></td>
</tr>
<tr>
<td>4d</td>
<td>Change the height of the chart to 4.7”. Allow the width to resize proportionally.</td>
<td>Change the height of the chart to 4.7” and the width to 10.71”.</td>
<td></td>
</tr>
</tbody>
</table>
Embed the file Support_SC_PPT16_10a_Incentive.docx available for download from the SAM website so that any edits you make only change the version you inserted in the presentation.

Link the chart from the file Support_SC_PPT16_10a_Market.xlsx available for download from the SAM website.

Link the chart using the destination theme from the file Support_SC_PPT16_Mac_10a_Market.xlsx available for download from the SAM website.

Change the height of the chart to 5". Allow the width to resize proportionally.

Link the table from the file Support_SC_PPT16_10a_Location.xlsx available for download from the SAM website.

Copy the range A1:B5 from the support file Support_SC_PPT16_Mac_10a_Location.xlsx available for download from the SAM website and paste it on Slide 7 keeping source formatting from the original file. (Hint: A Grant File Access dialog box may open. If this occurs, click Select..., and then click Grant Access.)

On Slide 6 ("Everyone Benefits"), link an Excel chart as follows:

- Link the chart from the file Support_SC_PPT16_10b_Jobs.xlsx available for download from the SAM website.

On Slide 6 ("Everyone Benefits"), link an Excel chart as follows:

- Link the chart using the destination theme from the file Support_SC_PPT16_Mac_10b_Jobs.xlsx available for download from the SAM website.

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>5a</td>
<td>Embed the file Support_SC_PPT16_10a_Incentive.docx available for download from the SAM website so that any edits you make only change the version you inserted in the presentation.</td>
<td>Embed the file Support_SC_PPT16_Mac_10a_Incentive.docx available for download from the SAM website. (Hint: Use Insert tab to select Object, and choose From File... to embed the .docx file. A Grant File Access dialog box may open. If this occurs, click Select..., and then click Grant Access.)</td>
<td></td>
</tr>
<tr>
<td>8a</td>
<td>Link the chart from the file Support_SC_PPT16_10a_Market.xlsx available for download from the SAM website.</td>
<td>Link the chart using the destination theme from the file Support_SC_PPT16_Mac_10a_Market.xlsx available for download from the SAM website. (Hint: To link the chart, open the Support_SC_PPT16_Mac_10a_Market.xlsx file, copy the chart, and paste the chart on Slide 6 Using Destination Theme &amp; Link Data. A Grant File Access dialog box may open. If this occurs, click Select..., and then click Grant Access.)</td>
<td></td>
</tr>
<tr>
<td>8b</td>
<td>Change the height of the chart to 5&quot;. Allow the width to resize proportionally.</td>
<td>Change the height of the chart to 5&quot; and the width to 6.86&quot;.</td>
<td></td>
</tr>
<tr>
<td>9a</td>
<td>Link the table from the file Support_SC_PPT16_10a_Location.xlsx available for download from the SAM website.</td>
<td>Copy the range A1:B5 from the support file Support_SC_PPT16_Mac_10a_Location.xlsx available for download from the SAM website and paste it on Slide 7 keeping source formatting from the original file. (Hint: A Grant File Access dialog box may open. If this occurs, click Select..., and then click Grant Access.)</td>
<td></td>
</tr>
<tr>
<td>9b</td>
<td>Use Smart Guides to position the table next to the text box as shown in Figure 2 below.</td>
<td>Change the height of the table to 2.33&quot; and the width to 3.02&quot;.</td>
<td></td>
</tr>
</tbody>
</table>
b. Change the height of the chart to 4.39 and the width to 7.25".
c. Use align commands to center the chart on the slide and align it to the middle of the slide.

(Website. (Hint: To link the chart, open the Support_SC_PPT16_Mac_10b_Jobs.xlsx file, copy the chart, and paste the chart on Slide 6 Using Destination Theme & Link Data. A Grant File Access dialog box may open. If this occurs, click Select…, and then click Grant Access.)

b. Change the height of the chart to 4.39 and the width to 7.25".
c. Use align commands to center the chart on the slide and align it to the middle of the slide.
d. Close the Support_SC_PPT16_Mac_10b_Jobs.xlsx file.

On Slide 7 (“The Engaged Millennial”), link to an Excel table as follows:

a. Link the table as an object from the file Support_SC_PPT16_10b_Millenials.xlsx available for download from the SAM website.
b. Use Smart Guides to position the linked table below the text box as shown in Figure 2 below.

d. Close the Support_SC_PPT16_Mac_10b_Millenials.xlsx file.

On Slide 7 (“The Engaged Millennial”), copy and paste an Excel table as follows:

a. Copy the range A1:B5 from Support_SC_PPT16_Mac_10b_Millenials.xlsx available for download from the SAM website and paste it on Slide 7 keeping source formatting from the original file.
b. Change the height of the table to 2.26" and the width to 3.7".
c. Use Smart Guides to position the table below the text box as shown in Figure 2 below.
d. Close the Support_SC_PPT16_Mac_10b_Millenials.xlsx file.

Shelly Cashman PowerPoint 2016 Module 11: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 1    | Haunted Food Fundraising guides organizations looking to a Halloween food-themed fundraising event. While their recipes range from cute to weird, you create a friendly photo album and a custom slide show they can distribute anywhere. After creating the first photo in a new photo album, you add the rest of the photos and modify the album for final distribution. With Slide 1 (“Haunted Food Fundraisers”) displaying, edit the existing photo album by inserting the following files available for download from the SAM website:  
  - Support_SC_PPT16_11a_Picture1.jpg  
  - Support_SC_PPT16_11a_Picture2.jpg  
  - Support_SC_PPT16_11a_Picture3.jpg  
  - Support_SC_PPT16_11a_Picture4.jpg  
  - Support_SC_PPT16_11a_Picture5.jpg  
  - Support_SC_PPT16_11a_Picture6.jpg  
  - Support_SC_PPT16_11a_Picture7.jpg | Removed. | Photo album option not available on MacOS. |
2. With the Edit Photo Album dialog box still displaying, format the photo album as follows:
   a. Insert a text box after Support_SC_PPT16_11a_Picture1.
   b. Rotate Support_SC_PPT16_11a_Picture2 to the right.
   c. Change the picture layout to 1 picture.
   d. Change the frame shape to Center Shadow Rectangle.
   e. Change the theme to Facet.thmx.
   f. Insert captions below all pictures and then update the photo album.

Shelly Cashman PowerPoint 2016 Module 11: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>• Faux Is Fabulous specializes in advanced-materials technology for fake leather and fur. With a new line of environmentally friendly fabrics ready to go into production, you help them create an appealing photo album and a custom slide show to show off their products. After creating the first photo in a new photo album, you add the rest of the photos and modify the album for final distribution. With Slide 1 (&quot;Faux Is Fabulous&quot;) displaying, edit the existing photo album by inserting the following files available for download from the SAM website: • Support_SC_PPT16_11b_Picture1.jpg • Support_SC_PPT16_11b_Picture2.jpg • Support_SC_PPT16_11b_Picture3.jpg • Support_SC_PPT16_11b_Picture4.jpg • Support_SC_PPT16_11b_Picture5.jpg • Support_SC_PPT16_11b_Picture6.jpg • Support_SC_PPT16_11b_Picture7.jpg</td>
<td>Removed.</td>
<td>Photo album option not available on MacOS.</td>
</tr>
<tr>
<td>2</td>
<td>With the Edit Photo Album dialog box still displaying, format the photo album as follows: a. Insert a text box after Support_SC_PPT16_11b_Picture1. b. Rotate Support_SC_PPT16_11b_Picture2 to the right. c. Change the picture layout to 1 picture. d. Change the frame shape to Rounded Rectangle. e. Change the theme to Gallery.thmx. f. Insert captions below all pictures and then update the photo album.</td>
<td>Removed.</td>
<td>Photo album option not available on MacOS.</td>
</tr>
<tr>
<td>Step</td>
<td>Windows</td>
<td>MacOS</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>1</td>
<td>On Slide 1 (&quot;Pedal to the Paddle Tours&quot;), use the Compare feature to compare two presentations, then select the file Support_SC_PPT16_CS4-7a_Comments.pptx, available for download from the SAM website, to merge with the current presentation. Show the Revisions pane and Comments pane, if necessary.</td>
<td>Removed.</td>
<td>Not available in PowerPoint 2016 for MacOS. The Start file has been recreated with the presentation merged and all the accept and reject change steps completed.</td>
</tr>
<tr>
<td>2</td>
<td>With Slide 1 still displaying, accept the change to the subtitle placeholder.</td>
<td>Removed.</td>
<td>Not available in PowerPoint 2016 for MacOS.</td>
</tr>
<tr>
<td>3</td>
<td>On Slide 3 (&quot;Specialty Adventures&quot;), respond to the changes as follows: a. Reject the change to the title placeholder. b. Reply to the comment with the following text: Thanks, we need to add that.</td>
<td>3a removed. 3b moved to step 1.</td>
<td>Not available in PowerPoint 2016 for MacOS.</td>
</tr>
<tr>
<td>4</td>
<td>On Slide 4 (&quot;Tours Sell Out Fast&quot;), accept the change to the title placeholder, and then delete the comment.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8a/6a</td>
<td>Apply the Complementary Color Emphasis animation.</td>
<td>Apply the Complementary Color Subtle animation. (Hint: Complementary Color Subtle animation is present in the Emphasis Effects category.)</td>
<td></td>
</tr>
<tr>
<td>11c/9c</td>
<td>Apply Layout 4 from the Quick Layout gallery.</td>
<td>Apply the fourth Quick Layout option containing the following options: Legend(Bottom), Data Labels (Outside End), Horizontal Axis, &amp; Vertical Axis (1&lt;sup&gt;st&lt;/sup&gt; column, 2&lt;sup&gt;nd&lt;/sup&gt; row in the Quick Layout gallery).</td>
<td></td>
</tr>
<tr>
<td>27/25</td>
<td>Set the Transitions Advance Slide timing for all slides to After 00:03.50.</td>
<td>On the Transitions tab, set the “After:” timing for all slides to 03.50.</td>
<td></td>
</tr>
<tr>
<td>28/26</td>
<td>On Slide 6 (&quot;Pack a Canoe&quot;) only, set the Transitions Advance Slide timing to After 00:05.00.</td>
<td>On the Transitions tab, set the “After:” timing for slides 6 (&quot;Pack a Canoe&quot;) only to 05.00.</td>
<td></td>
</tr>
</tbody>
</table>

Shelly Cashman PowerPoint 2016 Modules 8-11: SAM Capstone Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>On Slide 2 (&quot;To your good health&quot;), embed an Excel chart as follows: a. Embed the chart from the file Support_SC_PPT16_CS8-11a_Areas.xlsx available for download from the SAM website so that any edits</td>
<td>On Slide 2 (&quot;To your good health&quot;), copy and paste an Excel chart as follows: a. Open the Support_SC_PPT16_Mac_CS8-11a_Areas.xlsx file</td>
<td>Substeps a and d changed for Mac compatibility.</td>
</tr>
</tbody>
</table>

© 2018 Cengage Learning / Revised January 2018
<table>
<thead>
<tr>
<th></th>
<th>you make only change the version you inserted in the presentation. (Hint: To embed, use the Insert Object dialog box and select Create from file.)</th>
<th>available for download from the SAM website. Copy the Excel chart, and paste on Slide 2 using Destination Theme &amp; Embed Workbook. (Hint: A Grant File Access dialog box may open. If this occurs, click Select..., and then click Grant Access.)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>b.</td>
<td>Apply Style 6 to the chart.</td>
<td>b. Close the Excel support file.</td>
<td></td>
</tr>
<tr>
<td>c.</td>
<td>Add a chart title element and type Practice Areas in the new element.</td>
<td>c. Apply Style 6 to the chart.</td>
<td></td>
</tr>
<tr>
<td>d.</td>
<td>Change the height of the chart to 3.7&quot;. Allow the width to resize proportionally.</td>
<td>d. Add a chart title element above the chart and type Practice Areas in the new element.</td>
<td></td>
</tr>
<tr>
<td>e.</td>
<td>Use the Align Left and Align Middle align commands to position the chart on the slide.</td>
<td>e. Change the height of the chart to 3.35&quot; and the width to 5.58&quot;.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>f. Use the Align Left and Align Middle align commands to position the chart on the slide.</td>
<td></td>
</tr>
</tbody>
</table>

| 11e | Apply the Light Gradient – Accent 2 preset gradient fill style (2nd column, 1st row in the Preset gradients gallery). | Apply the Light Gradient preset gradient fill style (2nd column, 1st row in the Preset gradients gallery). |   |

| 12 | With Slide 3 still displaying, convert the bulleted list to the Chevron Accent Process SmartArt so viewers can easily see healthcare sectors as shown in Figure 3 below. | With Slide 3 still displaying, first convert the bulleted list to Basic Process and then immediately change the style to Accent Process within the drop-down Style menu on the SmartArt Design tab so viewers can easily see healthcare sectors as shown in Figure 3 below. | Chevron Accent Process not available in PowerPoint 2016 for MacOS. |

| 15a | Change the shading of the top row to Dark Gray, Text 2, Lighter 10% (4th column, 6th row of the Theme Color palette). | Change the shading of the top row to Gray-80%, Text 2, Lighter 10% (4th column, 6th row of the Theme Color palette). |   |

<p>| 19 | On Slide 6 (&quot;The Future Is Expansive&quot;), link to an Excel table as follows: Link the table as an object from the file Support_SC_PPT16_CS8-11a_Market.xlsx available for download from the SAM website. | On Slide 6 (&quot;The Future Is Expansive&quot;), copy and paste an Excel table as follows: Open Support_SC_PPT16_Mac_CS8-11a_Market.xlsx file available for download from the SAM website, Copy the Excel table, and Paste the Excel table on Slide 6 keeping the source formatting. Close the Excel Support file. |   |</p>
<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 4    | Insert a header as follows:  
   a. Insert a blank header at the top of the page.  
   b. Right-align the header paragraph.  
   c. Type Mathison as the header text, insert a space, and then insert a Plain Number page number from the Current Position gallery.  
   d. Close Header & Footer Tools.  
   Create a header to meet MLA standards as follows:  
   a. Insert a Top of page (Header) page number with Right alignment all pages in the document.  
   b. Edit the header, type Mathison and then close the Header and Footer area. | Reworked instructions  
   Menu options to insert headers differ on Mac | |
| 7    | In the sentence “In the United States...fresh fruits and vegetables.”, move the insertion point before the period and insert a citation to a new source using the information shown in Figure 1 below. (Hint: The Tag name is intentionally blurred because it is generated automatically.) | step removed | step removed  
   Sources created in Word for Mac cannot be graded accurately due to how they are stored in the file |
| 8    | Insert a citation to the existing Johnson source before the period in the third sentence, “Most food deserts are in cities such as...Oklahoma City.” | step removed | step removed  
   Sources and citations created in Word for Mac cannot be graded accurately due to how they are stored in the file |
| 10   | In the second paragraph, find the sentence “The aim is...growth.”  
   Move the insertion point before the period and insert a citation to a new source using the information shown in Figure 2 on the next page. (Hint: The Tag name is intentionally blurred because it is generated automatically.) | step removed | step removed  
   Sources created in Word for Mac cannot be graded accurately due to how they are stored in the file |
| 12   | Modify the Footnote Text style by changing its font size to 12 pt. and the line spacing to double.  
   Modify the Footnote Text style by changing the line spacing to double. | Removed instruction to modify the font size in the Footnote Text style  
   The font size of the Footnote Text style is 12 pt. by default on a Mac. | |
16 | Modify the “Works Cited” paragraph as follows:  
a. With the insertion point immediately before the “Works Cited” paragraph, insert a manual page break.  
b. Center the “Works Cited” paragraph on the new page 3. | Move the insertion point to the end of the document, and then insert a bibliography as follows:  
a. Insert a page break.  
b. Insert a Works Cited from the Bibliography gallery. | Updated instruction so students use the built-in Works Cited option  
The built-in bibliography option is not available on Mac. Students must use the build-in Word Cited option instead, which also inserts the “Works Cited” heading automatically. |

17 | With the insertion point in the left-aligned blank paragraph at the end of the document, use the Insert Bibliography command to insert a list of sources without a built-in heading. | Format the “Works Cited” heading as follows:  
a. Apply the Normal style to the heading.  
b. Center the heading. | Updated instruction so students format the automatically-inserted "Works Cited" heading appropriately for MLA style  
The built-in bibliography option is not available on Mac. Students must use the build-in Workd Cited option instead, which also inserts the “Works Cited” heading automatically. |

---

Shelly Cashman Word 2016 Module 2: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 4 | Insert a header as follows:  
a. Insert a blank header at the top of the page.  
b. Right-align the header paragraph.  
c. Type Reese as the header text, insert a space, and then insert a Plain Number page number from the Current Position gallery.  
d. Close Header & Footer Tools. | Create a header to meet MLA standards as follows:  
a. Insert a Top of page (Header) page number with Right alignment all pages in the document.  
b. Edit the header, type Reese and then close the Header and Footer area. | Reworked instructions  
Menu options to insert headers differ on Mac |
| 7 | Find the sentence “The scientists studying the problem called it Colony Collapse Disorder (CCD).” Move the insertion point before the period and insert a citation to a new source using the information shown in Figure 1 below. (Hint: The Tag name is intentionally blurred because it is generated automatically.) | step removed | step removed  
Sources created in Word for Mac cannot be graded accurately due to how they are stored in the file |
| 8 | Insert a citation to the existing Kaplan source before the period in the last sentence of the third paragraph, “These treatments are now part of regular beekeeping practices.” | step removed | step removed  
Sources and citations created in Word for Mac cannot be graded accurately due to how they are stored in the file |
| 10 | In the next sentence of the fourth paragraph, “Bees need a varied diet…Wellesley College.”, move the insertion point before the | step removed | step removed  
Sources created in Word for Mac cannot be graded accurately due to how they are stored in the file |
period and insert a citation to a new source using the information shown in Figure 2 on the next page. (Hint: The Tag name is intentionally blurred because it is generated automatically.)

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>To create a custom look for the letter, change the body font of the document theme to Cambria, and then save the customized theme font using Cover Letter as the name.</td>
<td>Removed from Mac project</td>
<td>Removed from Mac project Body font not available in Word for Mac</td>
</tr>
<tr>
<td>4</td>
<td>To further customize the document's appearance, apply the Basic (Elegant) style set.</td>
<td>Removed from Mac project</td>
<td>Removed from Mac project Style sets not available in Word for Mac</td>
</tr>
<tr>
<td>6</td>
<td>Delete the Position content control, which is not needed in this letter.</td>
<td>Removed from Mac project</td>
<td>Removed from Mac project Content controls created in Word for PC cannot be deleted in Word for Mac</td>
</tr>
<tr>
<td>8</td>
<td>In the “Requirements and Qualifications” table, move the “Client-focused team player” row so that it appears after the</td>
<td>Removed from Mac project</td>
<td>Removed from Mac project Rows cannot easily be moved in tables in Word for Mac</td>
</tr>
</tbody>
</table>
“Advanced communication skills” row to emphasize the communication skills.

7  New step added to Mac project  Delete the rectangle shape containing the signature.  New step added to Mac project

Extra rectangle present in Word for Mac signature

9  Add a row to the table and reduce the amount of typing required by copying and pasting a row as follows:
   a. Copy the “Advanced communication skills” row, and then paste it immediately above the “Microsoft Office proficiency” row so that it becomes the new row 5.
   b. In the new row 5, replace the text “Advanced communication skills” with the text Public speaking experience to add a requirement.

Removed from Mac project

Removed from Mac project

Rows cannot easily be pasted into tables in Word for Mac

<table>
<thead>
<tr>
<th>Shelly Cashman Word 2016 Module 5: SAM Project 1b</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step</strong></td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
9  Add a row to the table and reduce the amount of typing required by copying and pasting a row as follows:
   a. Copy the “Strong public service orientation” row, and then paste it immediately above the “Bachelor’s degree” row so that it becomes the new row 4.
   b. In the new row 4, replace the text “Strong public service orientation” with the text “Outstanding problem-solving skills to add a requirement.”

Removed from Mac project

Removed from Mac project

Rows cannot easily be pasted into tables in Word for Mac

Shelly Cashman Word 2016 Module 6: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 7    | To set up the document as a form letter, start the Step-by-Step Mail Merge Wizard, accept Letters as the document type, and then choose to use the current document as the starting document. Choose to create a new recipient list, and then customize the columns in the recipient list as follows:
   a. Customize the columns by deleting the Company Name, Country or Region, Work Phone, and E-mail Address fields.
   b. Rename the Home Phone field using Mobile Phone as the new field name.
   c. Add a new field to the end of the address list using Amount as the field name. | To set up the document as a form letter, start a Mail Merge and choose Letters as the document type. Choose to create a new recipient list, and then customize the field names in the recipient list as follows:
   a. Customize the list of field names by deleting the JobTitle, Company, Country/Region, and WorkPhone fields.
   b. Rename the HomePhone field using MobilePhone as the new field name.
   c. Add a new field to the end of the list using Amount as the field name.
   d. Save the recipient list using a name of your choice. | Update field names rather than columns; delete JobTitle and Company fields; save the recipient list
   No columns in recipient list interface in Word for Mac;
   different default fields available in Word for Mac; recipient list must be saved in Word for Mac before adding address information |
| 8    | Enter the address information for the two recipients shown in bold in Table 1 below, and then save the data source using a name of your choice. | Enter the address information for the two recipients shown in bold in Table 1 below, clicking OK when finished: | Data source not saved
   Saving data source not necessary in Word for Mac |
| 9    | Continue to Step 4 in the Mail Merge wizard, and then use the Date content control with the “CLICK HERE TO SELECT A DATE” placeholder text to select the date April 6, 2020. | Removed from Mac project | Removed from Mac project
   Date content controls not available in Word for Mac |
| 10   | Insert the inside address as follows:
   a. Select the placeholder text “INSERT INSIDE ADDRESS”, and then insert an AddressBlock | Insert the inside address as follows:
   a. Select the placeholder text “INSERT INSIDE ADDRESS”, and then Insert the inside address as follows:
   a. Select the placeholder text “INSERT INSIDE ADDRESS”, and then | Instruction to insert AddressBlock merge field removed
   Limited merge functionality available in Word for Mac |
<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 11    | Insert the greeting line as follows:  
   a. Select the placeholder text “INSERT GREETING LINE”, and then insert a GreetingLine merge field using the Dear Joshua: format.  
   b. Delete the placeholder text.  
| Insert the greeting line by selecting the placeholder text [FirstName] and then inserting the FirstName merge field.  
| Instruction to insert GreetingLine merge field removed  
Limited merge functionality available in Word for Mac |
| 14    | Continue to Step 5 of the Mail Merge wizard, and then edit the recipient list to sort the data records in ascending order by ZIP code in preparation for bulk mailing.  
| Filter the recipient list to sort the data records in ascending order by postal code in preparation for bulk mailing.  
| Reference to Mail Merge wizard removed  
Limited merge functionality available in Word for Mac |
| 15    | Complete the mail merge as follows in the lettered steps below. You will merge to a new document and then copy the contents of the merged file to the end of your original document, so that all of your assignment appears in the same file.  
   a. Continue to Step 6 of the Mail Merge wizard, and then merge all records to a new document.  
   b. In the new document containing the merged form letters, press CTRL+A to select all contents in the document, and then copy the selected text to the Office Clipboard.  
   c. In the document SC_WD16_6a_FirstLastName_2.docx, move the insertion point to the blank paragraph at the top of page 3, and then paste the merged form letter into the main document.  
   d. Verify that the pasted merged form letters appear only on pages 3–6 of the document SC_WD16_6a_FirstLastName_2.docx.  
   e. Delete the page break and the Next Page section break at the bottom of page 6 to make the document six pages long.  
   f. Turn off the preview of the mail merge results.  
   Close the new, merged document without saving it.  
| Complete the mail merge as follows in the lettered steps below. You will merge to a new document and then copy the contents of the merged file to the end of your original document, so that all of your assignment appears in the same file.  
   a. Merge all records to a new document by clicking Finish & Merge, then Edit Individual Documents.  
   b. In the new document containing the merged form letters, press Command+A to select all contents in the document, and then copy the selected text to the Office Clipboard.  
   c. In the document SC_WD16_Mac_6a_FirstLastName_2.docx, move the insertion point to the blank paragraph at the top of page 3, and then paste the merged form letter into the main document.  
   d. Verify that the pasted merged form letters appear only on pages 3–6 of the document SC_WD16_Mac_6a_FirstLastName_2.docx.  
   e. Delete the page break and the Next Page section break at the bottom of page 6 to make the document six pages long.  
   Close the new, merged document without saving it.  
| New merge instructions inserted  
Limited merge functionality available in Word for Mac |
### Shelly Cashman Word 2016 Module 6: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>To set up the document as a form letter, start the Step-by-Step Mail Merge Wizard, accept Letters as the document type, and then choose to use the current document as the starting document. Choose to create a new recipient list, and then customize the columns in the recipient list as follows: a. Customize the columns by deleting the Company Name, Country or Region, Work Phone, and E-mail Address fields. b. Rename the Home Phone field using Phone as the new field name. c. Add a new field to the end of the address list using Amount as the field name.</td>
<td>To set up the document as a form letter, start a Mail Merge and choose Letters as the document type. Choose to create a new recipient list, and then customize the field names in the recipient list as follows: a. Customize the columns by deleting the JobTitle, Company, Country/Region, and WorkPhone fields. b. Rename the HomePhone field using Phone as the new field name. c. Add a new field to the end of the address list using Amount as the field name. d. Save the recipient list using a name of your choice.</td>
<td>Update field names rather than columns; delete JobTitle and Company fields; save the recipient list No columns in recipient list interface in Word for Mac; different default fields available in Word for Mac; recipient list must be saved in Word for Mac before adding address information</td>
</tr>
<tr>
<td>9</td>
<td>Continue to Step 4 in the Mail Merge wizard, and then use the Date content control with the “CLICK HERE TO SELECT A DATE” placeholder text to select the date June 21, 2020.</td>
<td>Removed from Mac project</td>
<td>Removed from Mac project Date content controls not available in Word for Mac</td>
</tr>
<tr>
<td>10</td>
<td>Insert the inside address as follows: a. Select the placeholder text “INSERT INSIDE ADDRESS”, and then insert an AddressBlock merge field using the Mr. Joshua Randall Jr. format. b. Delete the placeholder text.</td>
<td>Insert the inside address as follows: a. Select the placeholder text “INSERT INSIDE ADDRESS”, and then insert the fields as shown in Figure 1 on the following page:</td>
<td>Instruction to insert AddressBlock merge field removed Limited merge functionality available in Word for Mac</td>
</tr>
<tr>
<td>11</td>
<td>Insert the greeting line as follows: a. Select the placeholder text “INSERT GREETING LINE”, and then insert a GreetingLine merge field using the Dear Joshua: format. b. Delete the placeholder text.</td>
<td>Insert the greeting line by selecting the placeholder text [FirstName] and then inserting the FirstName merge field.</td>
<td>Instruction to insert GreetingLine merge field removed Limited merge functionality available in Word for Mac</td>
</tr>
<tr>
<td>14</td>
<td>Continue to Step 5 of the Mail Merge wizard, and then edit the recipient list to sort the data records in ascending order by postal code in preparation for bulk mailing.</td>
<td>Filter the recipient list to sort the data records in ascending order by postal code in preparation for bulk mailing.</td>
<td>Reference to Mail Merge wizard removed Limited merge functionality available in Word for Mac</td>
</tr>
<tr>
<td>15</td>
<td>Complete the mail merge as follows in the lettered steps</td>
<td>Complete the mail merge as follows in the lettered steps</td>
<td>New merge instructions inserted</td>
</tr>
</tbody>
</table>
below. You will merge to a new document and then copy the contents of the merged file to the end of your original document, so that all of your assignment appears in the same file.

a. Continue to Step 6 of the Mail Merge wizard, and then merge all records to a new document.
b. In the new document containing the merged form letters, press CTRL+A to select all contents in the document, and then copy the selected text to the Office Clipboard.
c. In the document SC_WD16_6b_FirstLastName_2.docx, move the insertion point to the blank paragraph at the top of page 3, and then paste the merged form letter into the main document.
d. Verify that the pasted merged form letters appear only on pages 3–6 of the document SC_WD16_6b_FirstLastName_2.docx.
e. Delete the page break and the Next Page section break at the bottom of page 6 to make the document six pages long.
f. Turn off the preview of the mail merge results.

Close the new, merged document without saving it.

Limited merge functionality available in Word for Mac

Shelly Cashman Word 2016 Module 7: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>To increase the visual appeal of the newsletter, add a page border as follows: a. Add a Box page border to the document. b. Use the thin outer line and thick inner line Art border setting (15th option from the end of the Art list). c. Apply the Teal, Accent 4 color (8th column, 1st row of the Theme Colors palette).</td>
<td>To increase the visual appeal of the newsletter, modify the page border as follows: a. Use the Thick over bold double line border setting (9th option from the beginning of the style list). b. Apply the Teal, Accent 4 color (8th column, 1st row of the Theme Colors palette).</td>
<td>Instruction to add Box page border removed Different page border functionality available in Word for Mac</td>
</tr>
<tr>
<td>3</td>
<td>Create a nameplate for the newsletter as follows: a. Move the insertion point to the blank paragraph before “Monthly Newsletter”, and then insert</td>
<td>Create a nameplate for the newsletter as follows: a. Select the placeholder text reading “[Insert WordArt Here]” including the paragraph mark,</td>
<td>Instruction to select placeholder text rather than moving insertion point</td>
</tr>
<tr>
<td></td>
<td>WordArt using the Fill – Aqua, Accent 1, Shadow option from the WordArt gallery. (Hint: Depending on your version of Office, the WordArt may display as Fill: Aqua, Accent color 1; Shadow instead.) b. Type Springboard as the WordArt text. and then insert WordArt using the Fill – Aqua, Accent 1, Shadow option from the WordArt gallery. b. Type Springboard as the WordArt text.</td>
<td>Easier to select text in header rather than move insertion point in Word for Mac</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Format the WordArt shape as follows so it fills the space at the top of the newsletter: a. Change the text wrapping to Top and Bottom. b. Resize the WordArt to a height of 1.4&quot; and a width of 7&quot;.</td>
<td>Format the WordArt shape as follows so it fills the space at the top of the newsletter: a. Change the text wrapping to Top and Bottom. b. Resize the WordArt to a height of 1.4&quot; and a width of 6.5&quot;. c. Center-align the WordArt. Instruction to Center-align WordArt added; width of WordArt reduced Centering and reducing size of WordArt in this step ensures correct positioning in following steps</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>To make the nameplate more eye-catching, apply the following formatting to the WordArt text: a. Change the font to Century Schoolbook. b. Change the font size to 72 pt. c. Change the text fill color by applying the Radial Gradient - Accent 5 preset gradient fill color (5th column, 5th row of the Preset gradient gallery). (Hint: Display the Text Options tab in the Format Shape task pane.) d. Change the gradient Stop 2 and Stop 4 colors to Teal, Accent 4, Darker 25% (8th column, 5th row of the Theme Colors palette). e. Change the text outline color to Purple, Accent 5, Darker 25% (9th column, 5th row of the Theme Colors palette). f. Apply the Wave 2 text effect (2nd column, 5th row in the Warp section of the Transform gallery). (Hint: Depending on your version of Office, the text effect may display as Wave: Up instead.)</td>
<td>To make the nameplate more eye-catching, apply the following formatting to the WordArt text: a. Change the font size to 72 pt. b. Change the text fill color by applying the purple Radial Gradient preset gradient fill color (5th column, 5th row of the Preset gradient gallery). (Hint: Display the Text Options tab in the Format Shape task pane.) c. Change the gradient Stop 2 and Stop 4 colors to Teal, Accent 4, Darker 25% (8th column, 5th row of the Theme Colors palette). d. Add a Solid line text outline to the text, and set the text outline color to Purple, Accent 5, Darker 25% (9th column, 5th row of the Theme Colors palette). e. Apply the Wave 2 text effect (2nd column, 5th row in the Warp section of the Transform gallery). Instruction to changed font removed; text outline instructions updated WordArt already set to correct font in Word for Mac; different text outline options available in Word for Mac</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Separate the article from the issue information paragraph as follows: a. Apply a custom bottom border to the issue information paragraph (“Monthly Newsletter Issue 12”) using the solid bottom, gradient top border style (4th style from the bottom). b. Change the color of the border to Teal, Accent 4 (8th column, 1st row of the Theme Colors palette).</td>
<td>Separate the article from the issue information paragraph as follows: a. Apply a custom bottom border to the issue information paragraph (“Monthly Newsletter Issue 12”) using the Fade from top gradient line border style (4th style from the bottom). b. Change the color of the border to Teal, Accent 4 (8th column, 1st row of the Theme Colors palette). Different border style selected Different border options available in Word for Mac</td>
<td></td>
</tr>
</tbody>
</table>
10. Change the alignment of the article text as follows to use newspaper-style columns:
   a. Change the alignment of the first body paragraph (“Color plays...service branding.”) to Justify.
   b. With the insertion point in the first body paragraph, update the Article Text Style to match the current selection.

11. To insert a pull quote, move the insertion point to the beginning of the first body paragraph (“Color plays...service branding.”), and then insert a text box:
   a. Insert the Simple Text Box.
   b. Enter the following text into the text box: Color helps you decide what is important, appealing, and worthwhile.

Shelly Cashman Word 2016 Module 7: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 2    | To increase the visual appeal of the newsletter, add a page border as follows:  
   a. Add a Box page border to the document.  
   b. Use the diamond Art border setting (9th option from the end of the Art list).  
   c. Apply the Orange, Accent 2 color (6th column, 1st row of the Theme Colors palette).  
|       | To increase the visual appeal of the newsletter, modify the page border as follows:  
   a. Use the diamond Art border setting (9th option from the end of the Art list).  
   b. Apply the Orange, Accent 2 color (6th column, 1st row of the Theme Colors palette).  
|       | Instruction to add Box page border removed  
|       | Different page border functionality available in Word for Mac |
| 3    | Create a nameplate for the newsletter as follows:  
   a. Move the insertion point to the paragraph mark before “Monthly Newsletter”, and then insert WordArt using the Fill – Orange, Accent 1, Shadow option from the WordArt gallery. (Hint: Depending on your version of Office, the WordArt name may be named Fill: Orange, Accent color 1; Shadow instead.)  
   b. Type Career Smarts as the WordArt text.  
| Create a nameplate for the newsletter as follows:  
   a. Select the placeholder text reading “[Insert WordArt Here]” including the paragraph mark, and then insert WordArt using the Fill – Orange, Accent 1, Shadow option from the WordArt gallery.  
   b. Type Career Smarts as the WordArt text.  
| Instruction to select placeholder text rather than moving insertion point  
|      Easier to select text in header rather than move insertion point in Word for Mac |
| 4    | Format the WordArt shape as follows so it fills the space at the top of the newsletter:  
| Format the WordArt shape as follows so it fills the space at the top of the newsletter:  
| Width of WordArt reduced |
11. To insert a pull quote, move the insertion point to the beginning of the first body paragraph ("You are all set...and after the move."), and then insert a text box:
   a. Insert a Text Box.
   b. Enter the following text into the text box:
      The best way to know what to expect in a new city is to visit before you move.

---

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 11   | To insert a pull quote, move the insertion point to the beginning of the first body paragraph ("You are all set...and after the move."), and then insert a text box:
   a. Insert a Text Box.
   b. Enter the following text into the text box:
      The best way to know what to expect in a new city is to visit before you move. | Text Box rather than Simple Text Box inserted
Limited text box options available in Word for Mac | |
<table>
<thead>
<tr>
<th>Column</th>
<th>Task Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11d/8d</td>
<td>Change the height of the chart to 2.7” to create room for a second chart on the page.</td>
</tr>
<tr>
<td>13c/10c</td>
<td>Break the link to the Excel “Monetary Donations’ worksheet.</td>
</tr>
<tr>
<td>15e/12e</td>
<td>Add an Offset Right shadow shape effect (1st column, 2nd row in the Outer Shadow palette) to the entire chart.</td>
</tr>
<tr>
<td>15f/12f</td>
<td>Change the height of the chart to 2.7” to fit on the page.</td>
</tr>
<tr>
<td>18</td>
<td>Emily Adair saved a few steps by using a macro to set the paper size of all Adoptables forms. To change the form on page 7 to the new custom size the organization uses, edit and run the macro as follows: &lt;br&gt; a. Edit the SetForm macro in the Visual Basic Editor. &lt;br&gt; b. Change the PageWidth value to 9 to set the new width. &lt;br&gt; c. Change the PageHeight value to 6 to set the new height. &lt;br&gt; d. Save the revised macro and exit the Visual Basic Editor. &lt;br&gt; e. With the insertion point on page 7, run the SetForm macro to change the size of the form. Removed.</td>
</tr>
<tr>
<td>19/15</td>
<td>On page 7, use the table to control the layout of the form. If necessary, show table gridlines. In cell C3 of the form table, enter a content control as follows: &lt;br&gt; a. Position the insertion point before the space at the beginning of the cell containing “Pet profile writer”, and then insert a Check Box content control. &lt;br&gt; b. Change the properties of the check box to use Writer as the tag.</td>
</tr>
<tr>
<td></td>
<td>Sub steps b-c cannot be performed on a Mac.</td>
</tr>
</tbody>
</table>
c. Choose a setting so that no border is displayed around the check box.
d. Lock the content control so that it cannot be deleted.

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 2    | On page 3, insert a sidebar containing quotations from other study abroad students as follows:  
a. Choose Integral Sidebar as the text box type.  
b. Type the following sidebar title: Know Before You Go  
c. Copy all of the text from the file  
Support_SC_WD16_9a_Quotes.docx, available for download from the SAM website, and then paste it in the sidebar to replace the placeholder text.  
d. Delete the blank paragraph mark at the end of the sidebar text.  | On page 3, insert a sidebar containing quotations from other study abroad students as follows:  
a. Draw a text box (this will be the sidebar).  
b. Resize the sidebar on page 3 so that it is 5.0” tall and 2.25” wide.  
c. Position the sidebar in the Bottom Right.  
d. Using the format painter, update the formatting of the sidebar on page 3 to match the blank sidebar on page 4. | No text box type specified; instruction to resize text box added; instruction to position text box added; instruction to update formatting of text box added; instruction to add title and content removed.  
No text box types/styles available in Word for Mac; addition of content in next step. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 4    | Format the sidebar on page 3 as follows so it better suits the page design:  
a. Resize the sidebar on page 3 so that it is 5.0” tall.  
b. Position the sidebar in the Bottom Right with Square Text Wrapping. | Add content to the sidebar as follows:  
a. Copy all of the text from the file Support_SC_WD16_Mac_9a_Quotes.docx, available for download from the SAM website, and then paste it in the sidebar.  
b. Format the title “Know Before You Go” using the Franklin Gothic Medium (Headings) font and an 18 pt. font size. | Addition of content instruction added; instruction to position sidebar removed  
Formatting and positioning of text box in previous step   |
| 9    | Select a photo on page 5 and then compress all the pictures in the document using the Web (150 ppi) setting to reduce the file size. | Select a photo on page 5 and then compress all the pictures in the document using the On-Screen (150 ppi) setting to reduce the file size. | Different compression setting specified  
Different compression options available in Word for Mac |
| 13   | Position the insertion point before the page break on the new page you just inserted and then insert a table of contents using the Automatic Table 2 style in the Table of Contents gallery. | Position the insertion point before the page break on the new page you just inserted and then insert a table of contents using the Classic style in the Table of Contents gallery. | Different table of contents style specified  
Different table of contents styles available in Word for Mac |
| 19   | Add an entry to the index as follows to include a missing subtopic:  
a. In the “Trains” heading paragraph on page 9, mark an index entry that uses transportation as the main entry and trains as the subentry.  
b. Hide the formatting marks and index codes in the document, and then update the index to include the new entry.  
(Hint: If you are having trouble hiding the index codes, click the File tab and then click Options. In the left pane of the Word Options dialog box, click Display. If the Hidden text check box in the “Always show these formatting marks on the screen” section contains a checkmark, click the box to remove the checkmark, and then click OK.) | Add an entry to the index as follows to include a missing subtopic:  
a. In the “Trains” heading paragraph on page 9, mark an index entry that uses transportation as the main entry and trains as the subentry.  
b. Hide the formatting marks and index codes in the document, and then update the index to include the new entry.  
(Hint: If you are having trouble hiding the index codes, click Word and then click Preferences. Click View, and if the Hidden text check box under “Show Non-Printing Characters” contains a check mark, click the box to remove the check mark and then click OK.) | Hint on hiding index codes updated  
Different pathway for hiding index codes in Word for Mac |

**Shelly Cashman Word 2016 Module 9: SAM Project 1b**

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 2    | Insert a sidebar before the text that begins “Using the Smoothie Café Blender” as follows:  
a. Choose Integral Sidebar as the text box type. | Insert a sidebar before the text that begins “Using the Smoothie Café Blender” as follows:  
a. Draw a text box (this will be the sidebar). | No text box type specified; instruction to resize text box added; instruction to position text box added; instruction to update formatting of text box added;  |
| 4 | Format the sidebar on page 4 as follows so it better suits the page design:  
|   | a. Resize the sidebar on page 4 so that it is 6.5" tall.  
|   | b. Position the sidebar in the Bottom Right with Square Text Wrapping.  
|   | Add content to the sidebar as follows:  
|   | a. Copy all of the text from the file Support_SC_WD16_Mac_9b_Reviews.docx, available for download from the SAM website, and then paste it in the sidebar.  
|   | b. Format the title “Customer Reviews” using the Century Gothic (Headings) font and an 18 pt. font size.  
|   | c. Delete the blank paragraph mark at the end of the sidebar text.  
| 9 | Select the photo on page 9 and then compress all the pictures in the document using the Web (150 ppi) setting to reduce the file size.  
| 13 | Position the insertion point before the page break on the new page you just inserted and then insert a table of contents using the Automatic Table 1 style in the Table of Contents gallery.  
| 19 | Add an entry to the index as follows to include a missing subtopic:  
|   | a. In the “Cleaning” subheading on page 12, mark an index entry that uses blender as the main entry and cleaning as the subentry.  
|   | b. Hide the formatting marks and index codes in the document, and then update the index to include the new entry. (Hint: If you are having trouble hiding the index codes, click the File tab and then click Options. In the left pane of the Word Options dialog box, click Display. If the Hidden text check box in the “Always show these formatting marks on the screen” section contains a check mark, click the | Add an entry to the index as follows to include a missing subtopic:  
|   | a. In the “Cleaning” subheading on page 12, mark an index entry that uses blender as the main entry and cleaning as the subentry.  
|   | b. Hide the formatting marks and index codes in the document, and then update the index to include the new entry. (Hint: If you are having trouble hiding the index codes, click the File tab and then click Options. In the left pane of the Word Options dialog box, click Display. If the Hidden text check box in the “Always show these formatting marks on the screen” section contains a check mark, click the | Hint on hiding index codes updated  
|   | Different table of contents style specified  
|   | Different table of contents styles available in Word for Mac | Addition of content instruction added; instruction to position sidebar removed  
|   | Formatting and positioning of text box in previous step |  |
Shelly Cashman Word 2016 Module 9: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>As a marketing and sales assistant for the Montford Park Inn in Asheville, North Carolina, you are developing a survey to gather information about the inn. You plan to send the survey to customers via email and then ask them to fill in the survey and return it to you the same way. You need to complete the survey as an online form in a Word document. Start by changing the paper size to A5 (5.83 x 8.27 inches) so that customers do not need to scroll when completing the form online.</td>
<td>As a marketing and sales assistant for the Montford Park Inn in Asheville, North Carolina, you are developing a survey to gather information about the inn. You plan to send the survey to customers via email and then ask them to fill in the survey and return it to you the same way. You need to complete the survey as an online form in a Word document. Start by changing the paper size to A5 (5.83 x 8.26 inches) so that customers do not need to scroll when completing the form online.</td>
<td>A5 paper size specified as 5.83 x 8.26 rather than 5.83 X 8.27 Different default A5 paper size available in Word for Mac</td>
</tr>
<tr>
<td>4</td>
<td>Add text and content controls to the table in the form as follows: a. In the first cell of row 1, type First Name: followed by a space, and then insert a Plain Text content control. b. Edit the placeholder text so that it appears as: Click here to type your first name. (Hint: Switch to Design Mode to edit the placeholder text.) c. In the second cell of row 1, type Last Name: followed by a space, and then insert a Plain Text content control. d. Edit the placeholder text so that it appears as: Click here to type your last name.</td>
<td>Add text and content controls to the table in the form as follows: a. In the first cell of row 1, type First Name: followed by a space, and then insert a Text Box content control. b. Click the Options button, then insert the following default text: Click here to type your first name. c. In the second cell of row 1, type Last Name: followed by a space, and then insert a Text Box content control. d. Click the Options button, then insert the following default text: Click here to type your last name.</td>
<td>Text Box control specified rather than Plain Text content control; default text specified rather than placeholder text Limited content control functionality available in Word for Mac</td>
</tr>
<tr>
<td>5</td>
<td>Format the placeholder text of both content controls using the Strong style. Lock both content controls so they cannot be deleted.</td>
<td>Step removed from Mac project</td>
<td>Step removed from Mac project Styles not available for content controls in Word for Mac</td>
</tr>
<tr>
<td>6</td>
<td>In the first cell of row 3, enter text and a content control as follows: a. Position the insertion point before the space in the cell, and then insert a Check Box content control. b. Change the properties of the check box to use Website as the tag.</td>
<td>In the first cell of row 3, enter text and a content control as follows: a. Insert a Check Box content control. b. After the check box, insert a space, then enter Website as the label for the check box.</td>
<td>Instruction to add tag to content control removed; instruction to remove border from content control removed; Instruction to lock the content control removed Limited content control functionality available in Word for Mac</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
</tbody>
</table>
| c. Choose a setting so that no border is displayed around the check box.  
  d. Lock the content control so that it cannot be deleted.  
  e. Position the insertion point after the space in the cell, and then enter Website as the label for the check box. | After the “Other (please specify):” text, insert a space, then insert a content control on the same line as follows:  
  a. Insert a Rich Text content control.  
  b. Edit the placeholder text so that it appears as:  
  Click here to describe other ways you heard about us.  
  c. Format the placeholder text using the Quote style.  
  d. Lock the content control so that it cannot be deleted. | Instruction to insert Text Box rather than Rich Text control; default text rather than placeholder text specified; instructions to format the placeholder text and lock content control removed  
Limited content control functionality available in Word for Mac |
| 7 | After the “Other (please specify):” text, insert a space, then insert a content control on the same line as follows:  
  a. Insert a Text Box content control.  
  b. Click the Options button, then insert the following default text:  
  Click here to describe other ways you heard about us. | After the “What was your main reason for staying at the inn?” text, insert a space, then insert a content control on the same line as follows:  
  a. Insert a Combo Box content control.  
  b. Add Business, Vacation, and Visiting residents as the three choices available in the drop-down list. | Combo Box content control specified rather than Drop-Down List control; no placeholder text specified; Instructions to format placeholder text, lock content control, and delete “Choose an item” entry removed  
Limited content control functionality available in Word for Mac |
| 8 | After the “What was your main reason for staying at the inn?” text, insert a space, then insert a content control on the same line as follows:  
  a. Insert a Drop-Down List content control.  
  b. Edit the placeholder text so that it appears as:  
  Click the arrow to select from a list.  
  c. Format the placeholder text using the Quote style.  
  d. Lock the content control so that it cannot be deleted.  
  e. Delete the “Choose an item” entry.  
  f. Add Business, Vacation, and Visiting residents as the three choices available in the drop-down list. | After the “How would you rate your stay at the inn?” text, insert a space, then insert a content control on the same line as follows:  
  a. Insert a Combo Box content control.  
  b. Add Exceptional, Good, and Poor as the three choices available in the drop-down list. | Instructions to edit and format placeholder text removed; instruction to lock the content control removed; instruction to delete the “choose an item” entry removed  
Limited content control functionality available in Word for Mac |
| 9 | After the “How would you rate your stay at the inn?” text, insert a space, then insert a content control on the same line as follows:  
  a. Insert a Combo Box content control.  
  b. Edit the placeholder text so that it appears as:  
  Click the arrow to select from a list, or type a response.  
  c. Format the placeholder text using the Quote style.  
  d. Lock the content control so that it cannot be deleted. |   |   |
e. Delete the “Choose an item.” entry.

f. Add Exceptional, Good, and Poor as the three choices available in the combo box list.

| 10 | After the “Today's date:” text, insert a content control on the same line as follows:  
|    | a. Insert a Date Picker content control.  
|    | b. Edit the placeholder text so that it appears as: Click the arrow to select today's date.  
|    | c. Format the placeholder text using the Quote style.  
|    | d. Lock the content control so that it cannot be deleted.  
|    | e. Select the date format similar to October 14, 2018.  
|    | Text Box content control with Date field type inserted rather than Date Picker content control.  
|    | Limited content control functionality available in Word for Mac; No Date Picker content control unavailable in Word for Mac.

| 13 | Restrict editing in the document to allow users only to fill in forms, and start enforcing protection without a password.  
|    | Protect the form in the document to allow users only to fill in the form, and turn off shading in the form.  
|    | Specified protecting the form and turning off shading. Content controls cannot be locked individually in Word for Mac; Shading turned on by default in forms in Word for Mac.

### Shelly Cashman Word 2016 Module 9: SAM Project 1b

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>As part of the office staff at the Smile Dental Clinic in Santa Fe, New Mexico, you are developing a survey to gather information about the clinic. You plan to send the survey to customers via email and then ask them to fill in the survey and return it to you the same way. You need to complete the survey as an online form in a Word document. Start by changing the paper size to A5 (5.83 x 8.27 inches) so that customers do not need to scroll when completing the form online. (Hint: Depending on your version of Office, you may need to manually enter a height of 5.83 inches and a width of 8.27 inches within the Page Setup dialog box.).</td>
<td>As part of the office staff at the Smile Dental Clinic in Santa Fe, New Mexico, you are developing a survey to gather information about the clinic. You plan to send the survey to customers via email and then ask them to fill in the survey and return it to you the same way. You need to complete the survey as an online form in a Word document. Start by changing the paper size to A5 (5.83 x 8.26 inches) so that customers do not need to scroll when completing the form online. (Hint: Depending on your version of Office, you may need to manually enter a height of 5.83 inches and a width of 8.27 inches within the Page Setup dialog box.).</td>
<td>A5 paper size specified as 5.83 x 8.26 rather than 5.83 x 8.27. Different default A5 paper size available in Word for Mac.</td>
</tr>
<tr>
<td>4</td>
<td>Add text and content controls to the table in the form as follows:</td>
<td>Add text and content controls to the table in the form as follows:</td>
<td>Text Box control specified rather than Plain Text content control;</td>
</tr>
<tr>
<td>Step</td>
<td>Instructions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 1    | **a.** In the first cell of row 1, type First Name: followed by a space, and then insert a Plain Text content control.  
**b.** Edit the placeholder text so that it appears as:  
Click here to type your first name.  
(Hint: Switch to Design Mode to edit the placeholder text.)  
**c.** In the second cell of row 1, type Last Name: followed by a space, and then insert a Plain Text content control.  
**d.** Edit the placeholder text so that it appears as:  
Click here to type your last name.** |
| 2    | **a.** In the first cell of row 1, type First Name: followed by a space, and then insert a Text Box content control.  
**b.** Click the Options button, then insert the following default text:  
Click here to type your first name.  
**c.** In the second cell of row 1, type Last Name: followed by a space, and then insert a Text Box content control.  
**d.** Edit the placeholder text so that it appears as:  
Click here to type your last name.** |
| 3    | **a.** Format the placeholder text of both content controls using the Strong style. Lock both content controls so they cannot be deleted.** |
| 4    | **5**  
**6**  
**7**  
**8**  
**© 2018 Cengage Learning / Revised January 2018**
<table>
<thead>
<tr>
<th></th>
<th>a. Insert a Drop-Down List content control.</th>
<th>b. Edit the placeholder text so that it appears as: Click the arrow to select from a list.</th>
<th>c. Format the placeholder text using the Quote style.</th>
<th>d. Lock the content control so that it cannot be deleted.</th>
<th>e. Delete the “Choose an item.” entry.</th>
<th>f. Add 4 times a year, 2 times a year, Once a year, and Only when I feel pain as the four choices available in the drop-down list.</th>
<th>placeholder text, lock content control, and delete &quot;Choose an item&quot; entry removed</th>
<th>Limited content control functionality available in Word for Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>After the “How would you rate your overall experience at the Smile Dental Clinic?” text, insert a content control on the same line as follows:</td>
<td>a. Insert a Combo Box content control.</td>
<td>b. Add 4 times a year, 2 times a year, Once a year, and Only when I feel pain as the four choices available in the combo box list.</td>
<td>Instructions to edit and format placeholder text removed; instruction to lock the content control removed; instruction to delete the &quot;choose an item&quot; entry removed</td>
<td>Limited content control functionality available in Word for Mac</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>After the “Today's date:” text, insert a content control on the same line as follows:</td>
<td>a. Insert a Date Picker content control.</td>
<td>b. Select the date format similar to 1/17/2019.</td>
<td>Text Box content control with Date field type inserted rather than Date Picker content control</td>
<td>Limited content control functionality available in Word for Mac; No Date Picker content control unavailable in Word for Mac</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Restrict editing in the document to allow users only to fill in forms, and start enforcing protection without a password.</td>
<td>Protect the form in the document to allow users only to fill in the form, and turn off shading in the form.</td>
<td>Specified protecting the form and turning off shading</td>
<td>Content controls cannot be locked individually in Word for Mac; Shading turned on by default in forms in Word for Mac</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Shelly Cashman Word 2016 Module 11: SAM Project 1a

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
</table>
| 2    | The membership director saved a few steps by using a macro to set the paper size of all museum forms. To change to the new custom size the museum uses, edit and run the macro as follows:  
   a. Edit the FormSize macro in the Visual Basic Editor.  
   b. Change the PageWidth value to 8.5 to set the new width.  
   c. Change the PageHeight value to 5.5 to set the new height.  
   d. Save the revised macro and exit the Visual Basic Editor.  
   e. Run the FormSize macro to change the size of the form. | The membership director saved a few steps by using a macro to set the paper size of all museum forms. To change to the new custom size the museum uses, edit and run the macro as follows:  
   a. Edit the FormSize macro in the Visual Basic Editor.  
   b. Change the PageWidth value to 8.5 to set the new width.  
   c. Change the PageHeight value to 5.5 to set the new height.  
   d. Exit the Visual Basic Editor, then run the FormSize macro to change the size of the form. | Instruction to exit Visual Basic Editor and run macro rather than saving and running it added Macros save automatically in Word for Mac |
| 6    | Change the properties of the Date Picker content control next to “Today's date” to display the date using a format similar to 1/4/2018. | Step removed from Mac project  
Date Picker content controls not available in Word for Mac |  |
| 9    | Add a text box to the document encouraging members to donate to the museum as follows:  
   a. Draw a text box to the left of the picture of the dinosaur in the upper-right corner.  
   b. Adjust the size of the text box so it is 0.7” tall and 0.75” wide.  
   c. Type the following in the text box: Donate today!  
   d. Change the font size to 12 pt.  
   e. Center the text in the text box.  
   f. Apply the Fill – Brown, Accent 3, Sharp Bevel text effect to the text. (Hint: Depending on your version of Office, the text effect name may display as Fill: Brown, Accent color 3; Sharp Bevel instead.) | Add a text box to the document encouraging members to donate to the museum as follows:  
   a. Draw a text box to the left of the picture of the dinosaur in the upper-right corner.  
   b. Adjust the size of the text box so it is 0.7” tall and 0.75” wide.  
   c. Type the following in the text box: Donate today!  
   d. Change the font size to 12 pt.  
   e. Center the text in the text box.  
   f. Apply a White, Background 1 fill color to the text box (1st column, 1st row in the Theme Colors palette).  
   g. Apply the Fill – Brown, Accent 3, Sharp Bevel text effect to the text. (Hint: Depending on your version of Office, the text effect name may display as Fill: Brown, Accent color 3; Sharp Bevel instead.) | Instruction to add a White, Background 1 fill color to the text box added  
Shape background color is necessary for a shadow effect to apply properly to the text box in Word for Mac |
| 10   | Format the text box as follows so it appears to be part of the dinosaur picture:  
   a. Change the direction of the text to Rotate all text 270. | Format the text box as follows so it appears to be part of the dinosaur picture:  
   a. Change the direction of the text to Rotate all text 270.  
   b. Apply an Offset Right shadow. | Instruction to remove outline of text box removed; different absolute horizontal and vertical position specified  
No outline applied to text box by default in Word for Mac; different |
b. Remove the outline of the text box shape.
c. Apply an Offset Right shadow.
d. Apply the Isometric Bottom Down 3-D rotation effect.
e. Set the position of the text box object so it does not move with text, and then apply an absolute horizontal position of 4.7” to the right of the column and an absolute vertical position of 0.58” below the page.

<table>
<thead>
<tr>
<th>Step</th>
<th>Windows</th>
<th>MacOS</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>The membership coordinator saved a few steps by using a macro to set the paper size of all association forms. To change to the new custom size the association uses, edit and run the macro as follows:</td>
<td>The membership coordinator saved a few steps by using a macro to set the paper size of all association forms. To change to the new custom size the association uses, edit and run the macro as follows:</td>
<td>Instruction to exit Visual Basic Editor and run macro rather than saving and running it added Macros save automatically in Word for Mac</td>
</tr>
<tr>
<td></td>
<td>a. Edit the FormSize macro in the Visual Basic Editor.</td>
<td>a. Edit the FormSize macro in the Visual Basic Editor.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Change the PageWidth value to 8.5 to set the new width.</td>
<td>b. Change the PageWidth value to 8.5 to set the new width.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Change the PageHeight value to 5.5 to set the new height.</td>
<td>c. Change the PageHeight value to 5.5 to set the new height.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. Save the revised macro and exit the Visual Basic Editor.</td>
<td>d. Exit the Visual Basic Editor, then run the FormSize macro to change the size of the form.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>e. Run the FormSize macro to change the size of the form.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Change the properties of the Date Picker content control next to “Today’s date” to display the date using a format similar to 1/7/2019.</td>
<td>Step removed from Mac project Date Picker content controls not available in Word for Mac</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Add a text box to the document encouraging members to join the association as follows:</td>
<td>Add a text box to the document encouraging members to join the association as follows:</td>
<td>Instruction to add a White, Background 1 fill color to the text box added Shape background color is necessary for a shadow effect to apply properly to the text box in Word for Mac</td>
</tr>
<tr>
<td></td>
<td>a. Draw a text box to the left of the Organic picture in the upper-right corner of the document.</td>
<td>a. Draw a text box to the right of the Organic picture in the upper-right corner of the document.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Adjust the size of the text box so it is 0.6” tall and 0.75” wide.</td>
<td>b. Adjust the size of the text box so it is 0.6” tall and 0.7” wide.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Type the following in the text box:</td>
<td>c. Type the following in the text box:</td>
<td></td>
</tr>
</tbody>
</table>
| 10 | Format the text box as follows so it appears to be part of the Organic picture:  
|    | a. Change the direction of the text to Rotate all text 90.  
|    | b. Remove the outline of the text box shape.  
|    | c. Apply the Isometric Top Up 3-D rotation effect.  
|    | d. Set the position of the text box object so it does not move with text, and then apply an absolute horizontal position of 5.52” to the right of the column and an absolute vertical position of 0.84” below the page. |
| 12 | Apply the Stationery texture fill effect (4th column, 4th row of the Texture gallery) to the page background to give the form professional polish. | Format the text box as follows so it appears to be part of the Organic picture:  
|    | a. Change the direction of the text to Rotate all text 90.  
|    | b. Apply the Isometric Top Up 3-D rotation effect.  
|    | c. Set the position of the text box object so it does not move with text, and then apply an absolute horizontal position of 6.1” to the right of the column and an absolute vertical position of 0.38” below the page. |
|    | Instructions to remove outline of text box removed; different absolute horizontal and vertical position specified  
|    | No outline applied to text box by default in Word for Mac; different position necessary for correct placement of objects in Word for Mac |
|    | Instruction to add a page background color rather than texture fill effect added  
|    | Texture fill effects not available in Word for Mac |